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1. WPROWADZENIE

Gratulujemy! Zakupiłeś kompletny system treningowy, który pomoże ci w realizacji własnych potrzeb
treningowych. Instrukcja ta zawiera pełny spis funkcji, pomoże ci ona najlepiej poznać swojego Polara
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2. CZESCI SKLADOWE KOMPUTERA ROWEROWEGO

1. Polar CS600X: Zapisuje i wyświetla informacje o treningu i jeździe (podczas ćwiczenia).

2. Kodowany nadajnik Polar WearLink ® W.I.N.D. : Składa się z nadajnika i elektrod; przesyła sygnał tętna
do odbiornika.

3. CD-ROM: Zawiera oprogramowanie Polar Protrainer 5™ oraz instrukcję (aby pomóc Ci jak najlepiej
poznać Twojego Polara).

4. Uchwyt na rower Polar Bike Mount™: Zamontuj uchwyt na kierownicy a następnie umocuj na nim
Polara.

5. Sensor prędkości Polar Speed Sensor™ W.I.N.D.: Bezprzewodowy pomiar prędkości i dystansu.

Akcesoria (Opcjonalnie)

6. Sensor kadencji Cadence Sensor™ W.I.N.D.: Bezrzewodowy pomiar prędkości obrotu korby
(przedstawione w obrotach na minutę -rpm).

7. Sensor pomiaru mocy Power Output Sensor™ W.I.N.D.: Mierzy średnią i maksymalną kadencję, moc,
index pedałowania oraz balans pedałowania lewo/prawo.

8. Polar G3 GPS sensor W.I.N.D.: Za pośrednictwem technologii GPS podaje informacje o prędkości i
dystansie jak również dane o lokalizacji i przebytej trasie (we wszystkich sportach outdoorowych). Dane
o swojej trasie możesz przesłać do programu Polar ProTrainer 5 (aby wyświetlić je w Google Earth albo
przekonwertować na pliki GPX). Aby uzyskać więcej informacji, przeczytaj pomoc oprogramowania.

Gdy używasz sensora GPS G3 razem z sensorem prędkości, GPS będzie jedynie zapisywać informacje o
przebytej trasie. Jednakże, gdy sensor prędkości jest poza zasięgiem (np. typ treningu zmienił się w trakcie
trwania zapisu ćwiczenia), odbiornik automatycznie zacznie odbierać informacje o prędkości i dystanie z
sensora GPS. W ten sposób prędkość i dystans są zabezpieczone podczas sesji treningowej. Aby zacząć
używać sensora prędkości ponownie, przytrzymaj LIGHT i wybierz Seek sensor.
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3. ROZPOCZĘCIE

Przed aktywacją odbiornika, zmierz obwód koła swojego roweru.

Pomiar rozmiaru koła.
Podanie prawidłowego rozmiaru koła jest niezbędne do poprawnych wskazań. Są dwie metody
zmierzenia rozmiaru koła w rowerze:

Metoda 1

Spójrz na diametr w calach lub na ETRTO napisane na kole. Porównaj to z rozmiarem koła w milimetrach
w odpowiedniej kolumnie wykresu.

ETRTO Diametr wielkości koła (cale) Ustawienia rozmiaru koła (mm)

25-559 26 x 1,0 1884

23-571 650 x 23C 1909

35-559 26 x 1,50 1947

37-622 700 x 35C 1958

47-559 26 x 1,95 2022

20-622 700 x 20C 2051

52-559 26 x 2,0 2054

23-622 700 x 23C 2070

25-622 700 x 25C 2080

28-622 700 x 28 2101

32-622 700 x 32C 2126

42-622 700 x 40C 2189

47-622 700 x 47C 2220

Rozmiary kół w tabeli są sugerowane, wielkość koła zależy od typu obręczy i ciśnienia powietrza w kole.

Metoda 2

Zmierz obwód koła manualnie (aby wynik był jak najbardziej dokładny).

Użyj zasuwki aby zaznaczyć punkt, w którym koło dotyka ziemi Narysuj linię na ziemi aby zaznaczyć ten
punkt. Przesuń rower do przodu, na płaskiej nawierzchni, do pełnego obrotu koła Opona powinna być
prostopadle do ziemi. Narysuj kolejną linię na ziemi aby zaznaczyć dystans pełnej rotacji koła. Zmierz
dystans pomiędzy liniami.

Odejmij 4 mm od rachunku (z powodu swojej wagi koło będzie dociśnięte do podłoża a co za tym idzie,
odrobinę mniejsze). Wprowadź tę wartość do odbiornika

Podstawowe ustawienia
Przed użyciem Polara po raz pierwszy, dopasuj ustawienia podstawowe. Wprowadź jak najbardziej
dokładne dane, aby zapewnić jak najlepszy pomiar (w oparciu o osiągnięte przez ciebie wyniki).
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Aby przeglądać dane, używaj przycisków UP, DOWN ; potwierdzaj OK. Wartości będą zmieniać się
szybciej, jeżeli przytrzymasz przycisk UP lub DOWN.

1. Aby aktywować Polara, wciśnij dwukrotnie OK. Gdy zostanie aktywowany, nie może być już wyłączony!
2. Pojawi się logo Polar. Wciśnij OK.
3. Language: Wybierz English, Deutsch,Español,Français lub Italiano. Wciśnij OK.

4. Start with bike settings zostanie wy#wietlone. Wciśnij OK.
5. Ilość rowerów: Wybierz 1, 2 lub 3 - w zależności od tego, ile rowerów będziesz używać. Jeśli używasz

tylko jednego roweru, to ustawienia dla roweru 2 i 3 mogą zostać wprowadzone później. Celem
uzyskania dalszych informacji, przejdź do Ustawienia rowerowe. (strona 36).

6. (Kolo) Wheel: Wprowadź wielkość koła dla każdego roweru (mm). Celem uzyskania dalszych informacji,
przejdź do Pomiar rozmiaru koła. (strona 7).

7. Start with bike settings zostanie wy#wietlone. Wciśnij OK i uzupełnij następujące informacje:
8. Time: wybierz 12h lub 24h. Przy 12h, wybierz AM lub PM. Wprowadź czas lokalny.
9. Date: Wprowad# dzisiejsz# dat#; dd = dzie#, mm = miesi#c, yy = rok. Jeśli używasz trybu 12

godzinnego, ustaw datę; mm = miesiąc, dd = dzień, yy = rok.
10. (Jednostki) Units: Wybierz metryczne (kg/cm/km) lub brytyjskie (lb/ft/mi).
11. Weight: Wprowad# swoj# wag#. Aby zmienić jednostki, przytrzymaj LIGHT.
12. Height: Wprowadź swój wzrost. W formacie LB/FT najpierw wprowadź stopy, a potem cale.
13. Birthday: Wprowadź swoją datę urodzin; dd=dzień, mm=miesiąc, yy=rok
14. (Płeć) Sex: Wybierz Male lub Female.
15. Settings OK? zostanie wyświetlone. Wybierz Yes lub No. Wybierz Yes aby zaakceptować i zapisać

ustawienia. Odbiornik wyświetli aktualną godzinę. Wybierz No jeżeli ustawienia są błędne i wymagają
zmiany. Aby powrócić do danych, ktore chcesz zmienić, wciśnij STOP .
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Struktura Menu

Zakładanie uchwytu na rower
Możesz założyć uchwyt na rower po lewej lub prawej stronie kierownicy, lub na mostku.

1. Połóż gumową część na kierownicy / lub mostku i umieść na niej uchwyt.

2. Owiń podstawkę zipami i dostosuj ich długość do kierownicy/mostka. Przypnij uchwyt dokładnie. Odetnij
niepotrzebny nadmiar zipów.

Mocowanie licznika na podstawce
1) Umieść licznik na podstawce. Przekręć odbiornik zgodnie z ruchem wskazówek zegara do czasu, aż
usłyszysz kliknięcie.
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2) Odepnij licznik lekko go dociskając i obracając w przeciwną stronę do ruchu wskazówek zegara.
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4. PRZYGOTOWANIE DO CWICZEN

Planowanie treningu

Rodzaje ćwiczeń
Możesz użyć zainstalowanych w odbiorniku, gotowych ćwiczeń, lub stworzyć własne . Planuj i twórz
nowe, wszechstronne ćwiczenia; przesyłaj je do swojego licznika za pomocą oprogramowania Polar
ProTrainer 5. W celu uzyskania dalszych informacji o tym jak przesyłać pliki, przejdź doProgram
treningowy (strona 43).

Wybierz Settings > Exercise

Menu Exercises pokazuje listę ćwiczeń.

Poruszaj się pomiędzy opcjami za pomocą UP lub DOWN

• Free: Wolne ćwiczenie (bez żadnych ustawień).

• Basic: Trening o średniej intensywności. Czas trwania około 45 min.

• OwnZone: Ćwiczenie bazujące na OwnZone, ze średnią intensywnością. Polar jest w stanie
automatycznie wyznaczyć twoje indywidualne, tlenowe strefy tętna podczas rozgrzewki. Nazywa się to
OwnZone. Zalecany czas trwania ćwiczenia 45 minut. Celem uzyskania dalszych informacji, przejdź do
Wyznaczenie OwnZone (strona 22). W celu uzyskania dalszych informacji, przejdź doTrening OwnZone
(strona 57).

• Interval : Trening interwałowy rozpocznij od 15-minutowej rozgrzewki, następnie 5 km interwału (faza
ćwiczenia) z 5-minutową przerwą; powtórzyć 3 razy. Sesja kończy się 15-minutowym odpoczynkiem.

• Add new: Tworzenie i zapisywanie własnego ćwiczenia. Można sworzyć i przechowywać 10 ćwiczeń + 1
wolne ćwiczenie w liczniku.

Po dokonaniu wyboru ćwiczenia (Free, Basic, OwnZone, Interval lub dodaj nowe), wyświetlane są
następujące opcje. Wybierz pożadaną opcję i wciśnijOK.

1. Select ćwiczenie ustawione jako domyślne. Przy następnym treningu, twój licznik zaproponuje ci
ostatnie ćwiczenie jako domyślne.

2. View Ustawienia ćwiczeń. Przewiń UP lub DOWN aby przeglądać:

a. Trening w 1-3 stref: sprecyzuj limity tętna, prędkości/kadencji*/mocy* dla każdej ze stref,
timer/dystans dla strefy, lub

b. Ćwiczenie z wykorzystaniem faz: nazwa, opis, zakładany czas ćwiczenia. (Przytrzymaj LIGHT aby
wyświetlić wybrane fazy ze wskazanego profilu.)

3. Edytuj ćwiczenie Basic lub OwnZone aby dostosować je do swoich potrzeb. Możesz również edytować
ćwiczenie stworzone za pomocą licznika. W celu uzyskania dalszych informacji, przejdź do działu
"Tworzenie nowego ćwiczenia za pomocą licznika". Jeśli utworzyłeś ćwiczenie w oprogramowaniu Polar
ProTrainer, które zawiera fazy, nie możesz ich edytować za pomocą licznika.

4. (Zmiana nazwy) / Rename Basic, Interval lub inne ćwiczenia stworzone za pomocą licznika.

5. Default Powrót do ustawień domyślnych ćwiczeń Basic, Interval lub OwnZone.
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6. (Usu#) / Delete stworzone ćwiczenie używając odbiornika lub oprogramowania Polar ProTrainer 5.

* Wymagany jest opcjonalny sensor.

Tworzenie nowego ćwiczenia za pomocą odbiornika
Stwórz nowe ćwiczenie ze strefami

Stwórz swoje ćwiczenie za pomocą odbiornika

Wybierz Settings > Exercises > Add new

1. Ustaw ilość stref dla ćwiczenia (0-3) i wciśnij OK. Zobacz również Tworzenie nowego ćwiczenia bez
stref.

2. Wybierz typ strefy

A. Tętno

B. Prędkość

C. Kadencja*

D. Moc*

Wciśnij OK.

A. Dla heart rate, wybierz strefę lub manualnie ustaw strefę tętna. Wciśnij OK.

• Sport zone: Wybierz jedną ze stref (n.p. Z1: 50-59%HRmax) dla swojego ćwiczenia. Wciśnij OK aby
przejść do kroku 3.

Strefy sportowe Polara są zakresami intensywności pracy serca wyrażanymi w procentach z tętna
maksymalnego Domyślnie jest ustawionych pięć różnych stref: very light (bardzo niska) (50-59%
HRmax), light (niska) (60-69% HRmax), moderate (średnia) (70-79% HRmax), hard (wysoka) (80-89%
HRmax), and maximum (maksymalna) (90-99% HRmax). Domyślnie, wartość HRmax wyliczana jest ze
wzoru 220-wiek, lecz jeśli: znasz swoją wydolność tlenową i beztlenową; miałeś wyznaczone
przewidywane tętno maksymalne (HRmax -p) za pomocą Polar Fitness Test™; sprawdziłeś swoje tętno
maksymalne podczas badań - sam możesz zdefiniować, która ze stref będzie ci najbardziej odpowiadać.

• Manual: Ustaw wysoki i niski limit HR jako uderzenia na minutę (bpm) lub HR% / HRR%; wciśnij OK aby
przejść do kroku 3.

B. Jeśli wybrałeś speed, cadence* lub power* zones, ustaw górny i dolny limit strefy. Wciśnij OK aby
przejść do kroku 3.

• Jeśli wybrałeś kadencję jako typ strefy, to strefy będą przedstawione w obrotach na minutę (rpm).

• Jeśli wybrałeś moc jako typ strefy, to będzie ona przedstawiona w watach.

3. Ustaw Zone guide aby zmienić strefy po określonym czasie lub dystansie. Podczas treningu, licznik
zaalarmuje zmianę stref.

• Timers : Ustaw czas dla strefy (minuty i sekundy) i wciśnij OK.

• Distances: Ustaw dystans dla strefy i wciśnij OK.

• Off: Wyłącz timery oraz dystans i wciśnij OK.

Kiedy zdefiniujesz już pierwszą strefę, wyświetlony zostanie komunikat Zone 1 OK . Aby ustawić więcej niż
jedną strefę, powtórz krok 2 oraz 3 do momentu zdefiniowania wszystkich pożądanych stref.

Kiedy ćwiczenie będzie gotowe, New exercise added zostanie wyświetlone. Nowe ćwiczenie (NewExe) jest
zapisywane w menu Exercises, gdzie możesz wybrać je dla kolejnego treningu. Aby zmienić nazwę
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ćwiczenia wybierz opcję Rename.

Stwórz nowe ćwiczenie ze strefami

Aby utworzyć ćwiczenie bez stref, możesz używać timerów lub dystansu do prowadzenia treningu.

Wybierz Settings > Exercises > Add new

1. Number of zones : ustaw ilość stref na 0.

2. Guide type: Ustaw dźwięk timera podczas treningu (przypominający ci na przykład o tym, aby się napić),
lub ustaw dystans (dla kolejnych czasów okrążeń, bez zapisywania ich).

Timery

• Number of timers (liczba stoperów): Wybierz liczbę pomiarów czasu (1-3) dla sesji. Wciśnij OK.

• Timer 1 : Ustaw minuty i sekundy dla timera i wciśnij OK.

Dystanse

• Number of timers (liczba stoperów): Wybierz liczbę pomiarów czasu (1-3) dla sesji. Wciśnij OK.

• Distance 1: Wybierz dystans(y) i wciśnij OK.

Powtarzaj krok 2 do czasu, aż zdefiniujesz wszystkie timery i dystanse, Kiedy ćwiczenie będzie gotowe,
New exercise added zostanie wyświetlone. Nowe ćwiczenie (NewExe) jest zapisywane w menu Exercises,
gdzie możesz wybrać je dla kolejnego treningu. Aby zmienić nazwę ćwiczenia wybierz opcję Rename.

* Wymagany jest opcjonalny sensor.

Tworzenie nowego ćwiczenia za pomocą ProTrainera 5
Stwórz bardziej obszerne ćwiczenie używając Polar ProTrainera 5 W celu uzyskania dalszych informacji,
przejdź do pliku pomocy ProTrainera 5

Zakładanie nadajnika
Załóż nadajnik celem pomiaru pulsu.

1. Zmocz elektrody pod bieżącą wodą.

W ekstremalnych warunkach np. długie zawody, zalecamy używania specjalnego żelu (celem lepszego
przewodzenia sygnału / po zakończonych zawodach należy dokładnie umyć elektrody).

2. Przypnij nadajnik do elektrod . Wyreguluj długość elektrod tak, aby dokładnie przylegały do ciała.

3. Załóż i zapnij elektrody na wysokości klatki piersiowej, zaraz poniżej mięśni.

4. Upewnij się, że zmoczone elektrody dobrze przylegają do ciała, a logo Polara na nadajniku znajduje się
w pozycji centralnej.

Po zakończonym treningu zawsze odpinaj elektrody od nadajnika; zapobiegniesz w ten sposób
ich uszkodzeniu lub korozji. Dokładną instrukcję dotyczącą konserwacji elektrod znajdziesz w .
Konserwacja i przechowywanie (strona 60)

Nadajnik Polar WearLink może być używany ze specjalnym strojem sportowym, posiadającym wszyte
elektrody (z delikatnego materiału). Zwilż elektrody (znajdujące się na stroju). Wepnij nadajnik bezpośrednio
do elektrod wszytych w koszulkę tak, aby logo Polar było w prostej pozycji.

POLSKI

Przygotowanie do cwiczen 13



POLSKI

14 Przygotowanie do cwiczen



5. TRENING

Rozpoczęcie treningu
Załóż nadajnik i zamontuj Polara na podstawce.

1. Rozpocznij pomiar tętna naciskając OK. Licznik przejdzie w tryb pauzy.

2. Wybierz rower, na którym zamierzasz ćwiczyć. Bike 1 jest ustawiony domyślnie. Wybierz Settings >
Bike > Bike 1 / Bike 2 / Bike 3 > OK. Wybierz Other aby mierzyć tylko tętno, wysokość, temperaturę oraz
dane z sensora GPS.

Liczba w górnym prawym rogu wskazuje, który rower jest aktualnie używany. Możesz zmieniać rowery
przytrzymując DOWN podczas treningu. Aby zmienić ćwiczenie, przytrzymaj UP.

Tylko rowery, które są włączone ( ON) są pokazane w tej liście wyboru. Celem uzyskania dalszych
informacji, przejdź do Ustawienia rowerowe. (strona 36).

3. W ciągu czterech sekund, twoje tętno powinno pojawić się na wyświetlaczu. Obwódka wokół symbolu
serca oznacza, że transmisja jest kodowana. W zależności od tego, jakiego sensora używasz -
rowerowego lub GPS (lub obu) - symbol w dolnym lewym rogu będzie mrugać dopóki wszystkie sensory
nie zostaną odnalezione.

4. Zacznij ćwiczenie naciskając OK. Typ ćwiczenia jest wyświetlany w górnym lewym rogu ekranu.

Ewentualnie, wybierz Settings, Reset trip lub Location.

W Settings możesz zmienić lub przeglądnąć rózne ustawienia; przed rozpoczęciem treningu. Celem
dokładniejszych informacji na temat dostępności ustawień, przejdź do Ustawienia (strona 33). Menu
Settings zawiera następujące opcje:

• Exercise : Wybierz Free, Basic, OwnZone lub Interval i wciśnij OK (jeśli stworzyłeś nowe ćwiczenie,
również i ono zostanie tam wyświetlone).

1. Select : Ustaw ćwiczenie, które ma być wykonane domyślnie

2. View: Wgląd w ustawienia ćwiczenia.

• GPS: Włącz lub wyłącz funkcję GPS.

• Altitude: Ustaw wysokość.

• Rec.rate: Ustaw uśrednianie zapisu.

• RR data: Włącz lub wyłącz zapis RR.

• TZ Alarm: Włącz lub wyłącz dźwięk alarmu wyjścia poza strefę.

• HR view: Wybierz jak ma być przedstawione tętno - jako uderzenia na minutę (bpm), jako procent tętna
maksymalnego (HR%) lub jako procent z rezerwy tętna (HRR%).

• Bike: Wybierz rower 1, 2, 3 lub Other .

• A.Lap (Automatyczne okrążenia): Włącz (on) lub wyłącz (off) okrążenia automatyczne.

• Arr. time: Włącz lub wyłącz funkcję szacowanego czasu przyjazdu oraz ustaw dystans jazdy. Jeśli
włączyłeś opcję automatycznych okrążeń A.Lap, to dystans który ustawiasz będzie się tyczyć również
automatycznych okrążeń.

• Display: Modyfikacja wyświetlacza. Celem uzyskania dalszych informacji, przejdź do Personalizacja
wyświetlacza licznika (strona 17).
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W opcji Reset trip, możesz zresetować dystans wycieczki przed rozpoczęciem sesji treningowej.

W opcji Location**, możesz sprawdzić aktualną lokacje. Odbiornik określi twoją pozycję używając
ostatnich współrzędnych GPS. Szerokość i długość geograficzna są wyrażone w stopniach i minutach.
Liczba satelit jest widoczna w najniższym rzędzie.

Celem dalszej analizy trasy, przenieś dane do oprogramowania Polar ProTrainer 5. Aby uzyskać instrukcję,
przejdź do pliku pomocy oprogramowania .

Kilka skrótów, których możesz użyć podczas pauzy treningu:

• Przytrzymaj UP aby szybko zmienić typ ćwiczenia. Domyślnie ustawiony typ ćwiczenia to Free (wolne).

• Przytrzymaj DOWN aby szybko przełączać pomiędzy rowerami.

• Wciśnij BACK aby przejść w tryb godziny.

• Przytrzymaj LIGHT aby wyświetlić menu ustawień.

Jeśli aktywowałeś opcję autostartu, licznik automatycznie rozpocznie i zatrzyma zapis ćwiczenia kiedy
zaczynasz i kończysz jazdę. W celu uzyskania dalszych informacji na temat opcji AutoStart, przejdź
doUstawienia rowerowe. (strona 36). Licznik domyślnie wybierze rower, który był użyty podczas
poprzedniego ćwiczenia.

Jeśli (Nazwa #wiczenia) requiresSpeed/Cadence*/ Power* lub Exercise changed to Free zostanie
wyświetlone, oznacza to, że twoje ćwiczenie wymaga odpowiedniego sensora aby wyświetlać
prędkość/kadencję* lub informacje o mocy*.. ZobaczUstawienia rowerowe. (strona 36)aby wyświetlić
informacje o aktywowaniu sensorów dla Bike 1 / Bike 2 / Bike 3.

* Wymagany jest opcjonalny sensor.

Informacje na wyświetlaczu
Twój Polar oferuje ci podczas treningu możliwość przeglądania trzech różnych linii z informacjami
Naciskając UP lub DOWN, możesz zmieniać ekrany z informacjami o treningu. Nazwa ekranu pojawi się
po kilku sekundach. Nazwa widoczna jest w najniższym rzędzie informacji. Wyświetlacz zmienia się w
zależności od używanych sensorów, których opcje są włączone ON oraz od rodzaju przeprowadzanego
treningu.

Dopasuj licznik, w łatwy sposób, za pomocą oprogramowania Polar ProTrainer 5.

Domyślne informacje; wyświetlane na liczniku podczas używania sensora prędkości

Pr#dko##

Tętno
Dystans podróży
Prędkość w km/h

T#tno

Spalone kalorie / godzina
Dystans podróży
Aktualne tętno
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Stoper

Tętno średnie
Średnia prędkość
Stoper

Wysoko##

Godzina
Nachylenie
Wysokość w metrach

Wykres

Wykres tętna
Wykres wysokości
Stoper (Czas trwania treningu do tej pory)

Blokada strefy

Odliczanie czasu
Wskaźnik strefy
Aktualne tętno

Ustaw wyświetlacz tak, aby pokazywał pożądane przez ciebie informacje. ZobaczPersonalizacja
wyświetlacza licznika (strona 17).

* Opcjonalne sensory.

Widok wykresu
Widok wykresu umożliwia porównanie na nim dwóch wartości podczas treingu. Na przykład, wybierz
przegląd graficzny tętna oraz wysokości.

Widok wykresu może być dopasowany w zależności od potrzeb. Na górnym i środkowym rzędzie,
możesz ustawić wyświetlanie informacji o Mocy, Pr#dko#ci, Wysoko#ci oraz T#tnie na wykresach.

Personalizacja wyświetlacza licznika
Na ekranie głównym wybierz OK > Settings > Display > Edit

Spersonalizuj wyświetlacz swojego licznika tak, aby pokazywał pożądane podczas treningu informacje .
Możesz również edytować wyświetlacz za pomocą oprogramowania ProTrainer 5. Ćwiczenie dołączone
do programu treningowego ma własne ustawienia wyświetlacza (które nie mogą być zmieniane).
Informacje wyświetlane na ekranie zależne są od włączonych dodatków. Na przykład, jeśli pomiar
prędkości jest wyłączony, to informacje o prędkości nie będą dostępne na wyświetlaczu.

W celu uzyskania dalszych informacji o symbolach wyświetlacza, przejdź doSymbole na wyświetlaczu
(strona 18).

Wybierz ekran, który chcesz zmienić, za pomocą UP lub DOWN i wciśnij OK. Ustaw informacje dla
mrugającego górnego rzędu za pomocą UP lub DOWN a następnie wciśnij OK.

Powtórz tę samą operację dla środkowego i dolnego rzędu. Nazwa każdego ekranu pochodzi od
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informacji wyświetlanej w dolnym rzędzie. Aby powrócić do ustawień domyślnych ekranu, wciśnij i
przytrzymaj LIGHT (kiedy rzędy będą mrugać).

Aktywuj Titles (nagłówki) aby widzieć nazwę wyświetlacza podczas zmian widoku wyświetlanych w
trakcie ćwiczenia informacji:Z poziomu ekranu głównego, wybierz OK > Settings > Display > Titles

Ustawienia wyświetlacza są osobne dla każdego roweru (bike 1, 2, 3). Jeśli zmienisz wyświetlane informacje
dla jednego roweru, to zmiany nie będą dotyczyły pozostałych rowerów. Wygląd wyświetlacza zależny jest od
aktywnych dodatków. Celem uzyskania dalszych informacji, przejdź do Ustawienia funkcji (strona 33)
oraz Ustawienia rowerowe. (strona 36).

Symbole na wyświetlaczu

Symbol Wyjaśnienie

Godzina

Symbol roweru

Gdy symbol przestanie mrugać, to znaczy, że wszystkie potrzebne
sensory zostały odnalezione.

Symbol GPS

Gdy symbol przestanie mrugać, to znaczy, że wszystkie potrzebne
sensory zostały odnalezione.

Numer roweru

Liczba w dolnym prawym rogu wyznacza który rower jest używany
podczas aktualnego ćwiczenia

W##czenie blokady klawiszy

Wskazuje czy blokada klawiszy jest włączona.

Symbol zapisu #wiczenia

Jest widoczny podczas treningu gdy stoper jest włączony i aktywny jest
zapis.Symbol mruga gdy stan pamięci jest niski.

Ikona interwa#u

Wskazuje, że ćwiczenie interwałowe jest aktywne.

Odliczanie czasu Timer

Odliczanie czasu

Numer okr##enia i czas

Numer okrążenia i czas

Dystans okr##enia

Dystans aktualnego okrążenia

Stoper

Stoper (Czas trwania treningu do tej pory)

T#tno

Aktualne tętno

#rednie t#tno

Tętno średnie

Kalorie

Wydatek energetyczny w kcal lub Cal

Dystans

Dotychczasowy przebyty dystans
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Symbol Wyjaśnienie

Dystans wycieczki

Dystans pomiędzy punktami A i B Dystans jest resetowany za każdym
razem, gdy zostanie naciśnięty przycisk OK.

Czas przyjazdu.

Przewidywany czas przyjazdu.

Ró#nica RR

Różnice w interwałach tętna, np. różnice w czasach pomiędzy
uderzeniami serca.

Jazda Ekonomia

Ekonomia jazdy jako kcal/km lub Cal/mi oraz Kcal/H lub Cal/H.
Numeryczne porównanie efektywności jazdy oraz ekonomii pomiędzy

różnymi ćwiczeniami, lub okolicznościami (jak również pomiędzy
użytkownikami).

Suma wzniesie#

Suma wzniesień w metrach / stopach

Spadek

Suma spadków w metrach/stopach

Inklinometr

Kąt nachylenia terenu, z góry i pod górę, w procentach i stopniach.
Ocena, w formie numerycznej, jak stromy podjazd lub zjazd

pokonujesz; pomoże ci w odpowiedni sposób dopasować wysiłek

Wysoko##

Aktualna wysokość n.p.m.

Temperatura

Odczyt temperatury (°C).
Ponieważ ciepło twojego ciała ma wpływ na aktualny odczyt

temperatury, najlepszym sposobem na uzyskanie optymalnego
pomiaru, jest zdjęcie odbiornika z ręki na minimum 10 minut.

Kadencja*
Pomiar prędkości z jaką obracasz korbą w obrotach na minutę (rpm)

#rednia kadencja

Średnia kadencja.

Pr#dko##

Aktualna prędkość. Informacje dostarczane są z sensora prędkości.

Maksymalna pr#dko##

Maksymalna prędkość podczas treninigu Informacje dostarczane są z
sensora prędkości.

#rednia pr#dko##

Średnia prędkość z jaką jedziesz. Informacje dostarczane są z sensora
prędkości.

Moc*
Sensor mocy, mierzy aktualną, średnią oraz maksymalną wartość

mocy.

Peda#owanie index*

Opisuje nawet jaka siła jest produkowana podczas pedałowania.
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Symbol Wyjaśnienie

(balans lewo / prawo) L/R balance*

Podział mocy pedałowania pomiędzy lewą i prawą nogą; w procentach.

Zone pointer / wska#nik miejsca w strefie (tętno)
Jeżeli symbol serca nie jest widoczny i/lub słychać alarm, oznacza to,

że wyszedłeś poza wyznaczoną strefę tętna.

Zone pointer / wska#nik miejsca w strefie (strefy Polara)
Wskaźnik z symbolem serca, które, w zależności od tętna,

przemieszcza się w lewo i prawo wewnątrz skali sport zone, . Celem
uzyskania dalszych informacji o ustawieniach stref sportowych, przejdź

doFunkcje przycisków (strona 20).

Strefa docelowa

Wykres pokazujący zależność pomiędzy aktualnym tętnem a
ustawionymi limitami.

Zone pointer / wskaźnik miejsca w strefie (prędkość/rytm)
Jeżeli symbol nie jest widoczny i/lub słychać alarm, oznacza to, że

wyszedłeś poza wyznaczoną strefę.

Zone pointer*/ wskaźnik miejsca w strefie (kadencja)
Jeżeli symbol kadencji nie jest widoczny i/lub słychać alarm, oznacza

to, że wyszedłeś poza wyznaczoną strefę kadencji.

Zone pointer*/ wskaźnik miejsca w strefie (moc)
Jeżeli symbol mocy nie jest widoczny i/lub słychać alarm, oznacza to,

że wyszedłeś poza wyznaczoną strefę.

Czas w strefie

Czas spędzony w strefie

Pr#dko##/rytm*

Aktualna prędkość/rytm Dane pochodzą z sensora GPS G3 Ilość
kresek nad literą G wskazuje siłę sygnału sensora GPS.

Maksymalna pr#dko##*

Maksymana prędkość/rytm do tej pory Dane pochodzą z sensora GPS
G3

#rednia pr#dko##*

Maksymalna prędkość/rytm do tej pory Dane pochodzą z sensora GPS
G3

* Wymagany jest opcjonalny sensor.

Funkcje przycisków

Kolejne okrążenie
Wciśnij OK aby zapisać okrążenie. Na ekranie zostaną wyświetlone:

Numer okrążenia
Średnie tętno okrążenia
Czas okrążenia
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Numer okrążenia
Dystans okrążenia
Średnia prędkość

Blokada strefy
Kiedy ćwiczysz bez ustalonych wcześniej stref (ćwiczenie FREE), możesz zablokować swoje tętno w
wybranej strefie. Aby uzyskać więcej informacji, przejdź do Polar Sport Zones (strona 56). W ten sposób,
jeśli nie miałeś czasu na zdefiniowanie wcześniej stref dla ćwiczenia, możesz ustawić strefę podczas
treningu.

Przytrzymaj LAP (OK) aby Zablokowa# / Odblokowa# stref#.

Jeśli, na przykład, jedziesz z tętnem 130 bpm, które stanowi 75% twojego tętna maksymalnego i pasuje
do strefy 3, możesz przytrzymać LAP (OK) aby zablokować tętno w tej strefie. Sport zone3 Locked 70-79

zostanie wyświetlone. W przypadku wyjścia poza strefę, niezależnie czy jest to limit górny czy dolny,
odbiornik powiadomi cię o tym sygnałem (jeżeli funkcja target zone alarm jest włączona). Odblokuj strefę
poprzez ponowne przytrzymanie OK:Sport zone3 Unlocked zostanie wyświetlone.

Powiększenie Wyświetlacza

Wciśnij i przytrzymaj UP aby powiększyć górny rząd, oraz DOWN aby powiększyć środkowy rząd.
Powróć do normalnego wyświetlania, przytrzymując przycisk pomownie.

Podświetlenie ekranu (Night mode on)
Aby podświetlić ekran, wciśnij LIGHT podczas ćwiczenia. Tryb nocny jest włączony; ekran będzie
podświetlany automatycznie gdy jeden z przycisków zostanie naciśnięty lub faza ćwiczenia ulegnie
zmianie.

Wygląd menu Ustawień (Settings)
Przytrzymaj LIGHT > Settings

Menu Settings zostaje pokazane po przytrzymaniu LIGHT. W menu ustawień możesz zmieniać niektóre
wartości bez pauzowania zapisu ćwiczenia. Zawartość tego menu możesz zmieniać w zależności od typu
ćwiczenia. Celem uzyskania dalszych informacji, przejdź do Ustawienia (strona 33).
• Prev. phase / fazy: Przeglądanie informacji o podsumowaniach poprzednich faz lub powtórzeń

(wyświetlane gdy tworzysz ćwiczenie z fazami za pomocą oprogramowania Polar ProTrainer 5).
• Keylock: Blokowanie/odblokowanie klawiszy celem uniknięcia przypadkowego naciśnięcia przycisku.
• Autoscr / automatyczne przewijanie.: Włącz lub wyłącz opcję automatycznego przewijania

wyświetlanych informacji podczas treningu.
• TZ Alarm: Włącz/wyłącz alarm strefy.
• Change zone: Zmiana wyznaczonych stref (wyświetlane gdy zdefiniowałeś kilka stref; za wyjątkiem gdy

ćwiczenie z fazami zostało utworzone za pomocą oprogramowania Polar ProTrainer 5).
• HR view: Wybierz jak ma być pokazywane tętno.
• Seek sensor: Szukanie nadajnika WearLink, Prędkości, Kadencji* oraz Mocy*; jeśli sygnał zniknie
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podczas treningu z powodu zakłóceń.
• A.Lap:Włącza lub wyłącza funkcję automatycznych okrążeń.
• Arr. time: Włącza lub wyłącza szacowany czas przyjazdu.

Gdy już zmieniłeś ustawienia, licznik powróci do trybu ćwiczenia.

* Wymagany jest opcjonalny sensor.

Pauza podczas ćwiczenia
Dokonaj pauzy w zapisie ćwiczenia naciskając STOP.

W trybie pauzy, możesz wybrać:
• Continue, aby kontynuować zapis ćwiczenia.
• Exit, aby zatrzymać ćwiczenie.
• Summary, dla podsumowania funkcji
• Settings, by zmienić wszystkie ustawienia używane podczas treningu (włączając w to personalizację

wyświetlacza)do których nie ma dostępu podczas ćwiczenia.
• Reset, Aby usunąć zapisane informacje o ćwiczeniu. Potwierdź za pomocą OK i wciśnij OK ponownie,

aby wznowić zapis.
• Reset trip, aby zresetować dystans wycieczki. Potwierdź za pomocą OK i wciśnij OK ponownie, aby

wznowić zapis.
• Location*, dla aktualnej pozycji, używając ostatnich współrzędnych GPS.Szerokość i długość

geograficzna wyrażona jest w stopniach i minutach. Liczba dostępnych satelitów widoczna jest w
najniższym rzędzie.

• Free mode, aby zmienić profil ćwiczenia na FREE. Wykonywane przez ciebie ćwiczenie nie zostanie
usunięte; będzie natomiast kontynuowane bez ustawień. Jeśli uruchomisz tryb FREE, możesz
zresetować oryginalne ćwiczenie poprzez spauzowanie ćwiczenia ponownie i wybranie Restart P1.

*Wymagany jest opcjonalny sensor G3 GPS W.I.N.D.

Wyznaczenie OwnZone
Celem uzyskania dodatkowych informacji o Polar OwnZone®, przejdź do Trening OwnZone (strona 57).

Wybierz Settings > Exercise > OwnZone.

Wyznacz swoje OwnZone podczas 1-5 minutowej rozgrzewki; jadąc na rowerze lub biegając. Rozpocznij
ćwiczenie powoli, z małą intensywnością; następnie stopniowo zwiększaj tempo.

Wyznacz OwnZone na nowo, gdy:
• Zmieniasz otoczenie treningowe lub dyscyplinę sportu
• Gdy rozpoczynasz ćwiczenia po co najmniej tygodniowej przerwie.
• Jeśli nie jesteś całkiem pewny swojego stanu fizycznego lub psychicznego - na przykład, jeśli nie

odpocząłeś wystarczająco po ostatnim treningu, nie czujesz się dobrze lub jestes zestresowany.
• Po zmianie ustawień użytkownika.

Zanim zaczniesz wyznaczać swoje OwnZone, upewnij się, że:
• Ustawienia użytkownika są wprowadzone poprawnie.
• Funkcja OwnZone jest aktywna. Polar automatycznie wyznaczy OwnZone za każdym razem gdy

zaczniesz ćwiczenie z aktywną funkcją OwnZone.

1. Załóż nadajnik. Rozpocznij ćwiczenie dwukrotnie naciskając OK.
2. Gdy zaczniesz ćwiczenie, OZ zostanie wyświetlone i rozpocznie się wyznaczanie OwnZone.

Wyznaczenie OwnZone przebiega w 5 krokach. Jeśli dźwięk jest aktywny, to zostaniesz nim
poinformowany o zakończeniu każdego kroku.

OZ > Pedałuj wolnym tempem przez 1 minutę. Utrzymuj tętno poniżej 100 bpm/ 50% HR max podczas
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pierwszego kroku.

OZ > Pedałuj wolnym tempem przez 1 minutę. Powoli zwiększaj tętno o 10 bpm lu 5% HR max.

OZ > Pedałuj wolnym tempem przez 1 minutę. Powoli zwiększaj tętno o 10 bpm lu 5% HR max.

OZ > Pedałuj wolnym tempem przez 1 minutę. Powoli zwiększaj tętno o 10 bpm lu 5% HR max.

OZ > Pedałuj wolnym tempem przez 1 minutę. Powoli zwiększaj tętno o 10 bpm lu 5% HR max.

3. Gdy usłyszysz kolejne dwa sygnały dźwiękowe, oznaczać to będzie koniec wyznaczania OwnZone.
4. OwnZone Updated oraz strefy tętna zostaną wyświetlone. Strefa pokazana jest, w zależności od twoich

ustawień, w uderzeniach serca na minutę (bpm), lub jako procent tętna maksymalnego (HR%), bądź
jako procent z rezerwy tętna maksymalnego (HRR%).

5. Jeżeli wyznaczanie strefy nie powiedzie się, zostanie użyta twoja ostatnia, wyznaczona strefa i OwnZone

Limits zostanie wyświetlone Jeżeli wcześniej OwnZone nie było zapisywane, pojawią się,
automatycznie, limity wyznaczone na podstawie wieku.

Kontynuuj ćwiczenie. Celem optymalizacji efektów, staraj się ćwiczyć w wyznaczonej strefie.

Ewentualnie, aby pominąć wyznaczanie OwnZone i użyć ostatnio wyznaczonej strefy, naciśnij OK w
którymkolwiek momencie tego procesu.

Czas użyty na wyznaczenie OwnZone został doliczony do zapisanego czasu treningu

Zatrzymanie ćwiczenia
Dokonaj pauzy w zapisie ćwiczenia naciskając STOP. Aby całkowicie zatrzymać zapis, wybierz EXIT.
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6. ZAKOŃCZENIE TRENINGU

Dbanie o nadajnik po zakończeniu ćwiczenia. Odpinaj nadajnik od elektrod po każdym użyciu.
Przechowuj nadajnik suchy i czysty.

Celem poznania szczegółów dotyczących konserwacji i przechowywania, przejdź do Konserwacja i
przechowywanie (strona 60).

Analiza wyników ćwiczenia

Aby zobaczyć podstawowe informacje o danych ze swoich osiągów, przejdź do File w liczniku. Celem
dokładnej analizy, przenieś dane do Polar ProTrainer 5. Oprogramowanie to oferuje różnorodne opcje
analizy danych.

Polar łączy się z oprogramowaniem za pomocą czytnika IrDA. Najpierw uruchom program. Następnie
wybierz Connect na odbiorniku i połóż go naprzeciwko okienka podczerwieni w czytniku Polar IrDA USB
podpiętego do komputera (bądź innego kompatybilnego czytnika IrDA). Celem uzyskania pełnej instrukcji
dotyczącej przesyłania danych, przejdź do pliku pomocy oprogramowania.

1. Uruchom oprogramowanie Polar ProTrainer 5

2. Wybierz Connect w odbiorniku i połóż go naprzeciwko okienka podczerwieni.

3. Kliknij Po##cz z monitorem na pasku narzędzi oprogramowania..

Celem uzyskania dalszych informacji o przesyle danych, przejdź do pliku pomocy programu.

Przeglądanie plików w Polarze

Wybierz File > OK dla następujących opcji:
• Exercise log pokazuje maksymalnie 99 plików ćwiczeń.
• Weekly zawiera podsumowania z ostatnich 16 tygodni.
• Totals Pokazuje ogólną wartość informacji o ćwiczeniach.
• W Delete menu możesz usuwać pliki z ćwiczeniami.

Exercise Log
Wybierz File > Exercise log

Detale dotyczące sesji treningowej możesz zobaczyć w Exercise log. Następujące informacje zostaną
wyświetlone:
• Nazwa ćwiczenia.
• Słupek obrazujący dane ćwiczenie. Wysokość słupka wskazuje czas trwania ćwiczenia.
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• Data ćwiczenia.

Informacje pojawiające się na wyświetlaczu (a - e opisane poniżej) są zależne od ustawień i typu
ćwiczenia (np. jeśli twoje ćwiczenie nie zawiera faz, to informacja o nich nie będzie wyświetlana).

Przeglądaj ćwiczenia za pomocą UP lub DOWN ; wciśnij OK aby je otworzyć:

A. (Podstawowe) Basic informacje

B. Bike informacje (o rowerze)

C. Sport zones informacje (o strefach)

D. Phases informacje (o fazach)

e. Laps informacja (o okrążeniach)

A. (Podstawowe) Basic informacje

Wybierz File > Exercise log Przewiń UP lub DOWN aby wybrać ćwiczenie i wciśnij OK. Przewiń UP lub
DOWN aby przeglądnąć następujące informacje:

Nazwa #wiczenia

Czas kiedy ćwiczenie się rozpoczęło
Przebyty dystans
Ogólny czas ćwiczenia

(T#tno) Heart rate w uderzeniach na minutę (bpm), lub w procentach tętna
maksymalnego (HR%), bądź w procentach rezerwy z tętna maksymalnego
(HRR%).
Tętno maksymalne
Tętno minimalne
Tętno średnie
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Po##dane strefy (HR / Pr#dko## /Kadencja*/moc*) , przełączanie
pomiędzy zone 1, zone 2, lub zone 3.
Górny limit
Dolny limit

Czas w strefach, powy#ej oraz poni#ej stref 1/2/3

Czas powyżej strefy
Czas poniżej strefy
Czas w strefie

Calories (kalorie) spalone podczas #wiczenia.

Wydatek kaloryczny wskazuje całkowity wysiłek podczas ćwiczenia.

Wciśnij BACK aby powrócić do wglądu w informacje podstawowe.

Dodatkowe informacje podstawowe

Aby dodać własne informacje o ćwiczeniu lub je usunąć z File (pliki), przytrzymaj LIGHT będąc w widoku
informacji podstawowych.

Wybierz File > OK > Exercise log > OK > Basic > OK , przytrzymaj LIGHT> Add info >OK.

• Rank (ranga): Stopień ćwiczenia.
• Feeling : Określa twoje samopoczucie podczas treningu.
• Temperat .: Ustaw temperaturę za pomocą UP lub DOWN.
• Distance:Ustaw dystans dla Bike 1, Bike 2, Bike 3 lub innych.

Jeśli zmienisz dystans, będzie to miało również wpływ na ogólną ilość przejechanych kilometrów.

B. Bike informacje (o rowerze)

Wybierz File > Exercise log > Bike information .

Wciśnij OK i przewiń UP lub DOWN aby przeglądać informacje o rowerze:

Pr#dko##

Prędkość maksymalna
Średnia prędkość
Dystans

Kadencja

Kadencja maksymalna
Kadencja średnia
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Moc

Maksymalna moc
Średnia moc
Efektywno## jazdy

Efektywność jazdy to wydatek energetyczny przetworzony
w moc, która porusza rower do przodu. Efektywność
jazdy jest mierzona od momentu gdy tętno przekroczy
100 bpm/min i ćwiczenie trwa conajmniej jedną minutę.
Jeśli tętno spadnie poniżej 100 bpm/min podczas
ćwiczenia, to mierzenie efektywności jazdy zostanie
zatrzymane do czasu, aż tętno na powrót wzrośnie do
100 bpm/min. Poprawianie efektywności jazdy wskazuje
poprawę ekonomii jazdy.

Balans lewo / prawo

Balans lewo / prawo w %
Index pedałowania w %

Ilo## spalanych kalorii na kilometr

Nachylenie

Maksymalne nachylenie w %
Maksymalne nachylenie w stopniach

Odchylenie

Maksymalne odchylenie w %
Maksymalne odchylenie w stopniach

Wysoko##

Wysokość maksymalna
Wysokość minimalna
Wysokość średnia

Wzniesienie/spadek terenu

Suma wzniesień w metrach / stopach
Suma spadków w metrach/stopach

Temperatura

Maksymalna temperatura oC w stopniach
Minimalna temperatura oC w stopniach
Średnia temperatura oC w stopniach
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Odometr

Rower 1, 2 lub 3
Kilometry

C. Sport zones

Wybierz File > Exercise log > Basic > OK

Na ekranie informacji podstawowych, wciśnij DOWN aby zobaczyć informację o Sport zones.

Wciśnij OK i przewiń za pomocą UP lub DOWN aby zobaczyć czas spędzony w każdej strefie.. Tutaj,
zmiany w sesjach zaprezentowane są w formie graficznej.

Wciśnij BACK aby powrócić do wglądu w informacje o fazach ..

D. Fazy

Wybierz File > Exercise log > Phases

Menu Phases (faz) jest wyświetlane tylko wtedy, gdy ćwiczenie jest stworzone za pomocą
oprogramowania ProTrainer 5 i zawiera fazy.

Przegląd informacji w Sport zones; wciśnij DOWN aby przejrzeć informację o Phases. Każda faza może
być przeglądana oddzielnie

Przewijaj dane wybranej fazy poprzez naciśnięcie OK. Możesz dokonać porównania faz poprzez
naciśnięcie UP lub DOWN.

Nazwa fazy

Czas podziału
Czas trwania danej fazy

(T#tno) Heart rate w uderzeniach na minutę (bpm), lub w procentach tętna
maksymalnego (HR%), bądź w procentach rezerwy z tętna maksymalnego
(HRR%).
Tętno maksymalne
Tętno średnie

POLSKI

28 Zakończenie treningu



Ró#nica wzrostu HR / Odnowy HR / HR.

Różnica pomiędzy tętnem na początku i na końcu fazy (Tętno) Heart rate w
uderzeniach na minutę (bpm), lub w procentach tętna maksymalnego (HR%), bądź
w procentach rezerwy z tętna maksymalnego (HRR%).
Wzrost HR: Jeśli tętno było niższe na początku fazy niż na końcu, to licznik
pokaże tę różnicę w tętnie (tętno końcowe minus tętno początkowe). Podczas
trwania fazy, licznik pokaże wartość wzrostu tętna.
Odnowienie HR: Jeśli tętno było wyższe na początku fazy niż na końcu, to
licznik pokaże tę różnicę w tętnie (tętno początkowe minus tętno końcowe).
Podczas trwania fazy, licznik pokaże wartość wzrostu tętna.
Różnice HR: Jeśli wartość tętna była taka sama na początku i na końcu fazy, to
licznik pokaże różnicę tętna jako 0.

Pr#dko##

Prędkość maksymalna
Średnia prędkość

Dystans

Dystans podziału
Dystans danej fazy

Kadencja*
Kadencja maksymalna
Średnia kadencja aktualnej fazy

Moc

Maksymalna moc
Średnia kadencja aktualnej fazy

Wciśnij BACK aby powrócić do Phases.

* Wymagany jest opcjonalny sensor.

e. Okrążenia

Wybierz File > Exercise log > Basic > Laps

W informacjach o fazach, przeglądaj informacje o okrążeniach naciskając DOWN. Okrążenia pokazane
są jeśli więcej niż jedno jest zapisane w pamięci licznika.

Number of recorded laps/automatic laps (informacje o okrążeniach wraz z
informacjami o automatycznych okrążeniach)
Średni czas okrążenia / automatycznego okrążenia.
Najlepsze (najszybsze) okrążenie / automatyczne okrążenie jest pokazywane wraz
z jego czasem

Ostatnie okrążenie nie jest nigdy wyświetlane jako najlepsze (nawet gdy było najszybsze). Jeśli bierzesz
udział w zawodach i chciałbyć zawrzeć w nich ostatnie okrążenie, wciśnij OK na lini mety zamiast STOP.
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Po osiągnięciu linii mety możesz przerwać zapis.

Przeglądnij informacje o okrążeniu naciskając OK.

Porównaj informacje o różnych okrążeniach używając UP lub DOWN.

Dla łatwiejszego przeglądu informacji o okrążeniach, prześlij dane do oprogramowania ProTrainer 5 i
analizuj je na wykresach.

Czas

Czas podziału
Czas okrążenia

(T#tno) Heart rate w uderzeniach na minutę (bpm), lub w procentach tętna
maksymalnego (HR%), bądź w procentach rezerwy z tętna maksymalnego
(HRR%).
Tętno maksymalne
Tętno średnie
Końcowe tętno okrążenia

Pr#dko## w km/h

Średnia prędkość
Końcowa prędkość okrążenia
Przytrzymaj LIGHT aby zmienić prędkość.

Dystans

Dystans okrążenia

Kadencja*
Maksymalna
Średnia kadencja okrążenia

Moc*
Średnia kadencja okrążenia
Końcowa moc okrążenia

Index peda#owania

Średnie %
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Efektywno## jazdy

Efektywność jazdy to wydatek energetyczny przetworzony w moc ,która porusza
rower do przodu. Efektywność jazdy jest mierzona od momentu gdy tętno
przekroczy 100 bpm/min i ćwiczenie trwa conajmniej jedną minutę. Jeśli tętno
spadnie poniżej 100 bpm/min podczas ćwiczenia, to mierzenie efektywności jazdy
zostanie zatrzymane do czasu, aż tętno na powrót wzrośnie do 100 bpm/min.
Poprawianie efektywności jazdy wskazuje poprawę ekonomii jazdy.

Nachylenie

Nachylenie w %
Nachylenie w stopniach

Wysoko##

Suma wzniesień
Wysokość

Wysoko##

Spadek
Wysokość

Temperatura

Wciśnij BACK aby powrócić to wglądu w informacje podstawowe.

* Wymagany jest opcjonalny sensor.

Podsumowanie tygodnia
Wybierz File > Weekly

W podsumowaniach (tygodniowych) Weekly możesz mieć wgląd w ostatnie 16 tygodni treningu.. Słupek
po prawej stronie nazwany This week wyświetla podsumowanie ćwiczenia tylko dla aktualnego tygodnia.
Poprzednie słupki są datowane w niedziele. Przewijaj wyświetlone tygodnie za pomocą UP lub DOWN ;
w dolnym rzędzie przeglądaj czas trwania ćwiczenia .

Wybierz tydzień za pomocą OK aby zobaczyć spalone kalorie, dystans i czas ćwiczenia w tym tygodniu.

Wciśnij DOWN aby zobaczyć tygodniowe strefy.
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Aby zobaczyć czas spędzony w każdej strefie, wciśnij OK i przeglądaj strefy za pomocą UP lub DOWN.

Totals
Wybierz File > Totals

Totals zawierają sumaryczne informacje o zapisanych wynikach (od czasu ostatniego resetu).
Wykorzystaj wartości z Totals jako sezonowe lub miesięczne kontrasty plików ćwiczeń. Wartości
uaktualniane są automatycznie; gdy zapis ćwiczenia został zatrzymany.

Używaj UP lub DOWN aby poruszać się po następujących informacjach:
• Bike 1 distance (skumulowany dystans dla roweru 1; może być zresetowany)
• Bike 2 distance (dystans)
• Bike 3 distance (dystans)
• GPS distance (dystans)
• Total distance (dystans) (ogólny dystans; może być zresetowany)
• Ca#kowity czas

• Ca#kowity wydatek energetyczny:

• Ogólny rachunek #wiczenia

• Ca#kowita suma podej##:

• Total odometer (Łączny dystans nie może być zresetowany)
• Reset totals

W celu wyzerowania wartości totals

Wybierz File > Totals > Reset totals

Wybierz wartość, którą chcesz zresetować z menu i potwierdź naciskając OK. Wybierz Yes aby
potwierdzić reset. Skasowanych danych nie można odzyskać. Wybierz No aby powrócić do menu
Reset.

Kasowanie plików
Wybierz File > Delete > Exercise

W Delete możesz usunąć wcześniejsze ćwiczenia pojedynczo, wszystkie lub wartości total.

Poruszaj się po następujących informacjach za pomocą UP lub DOWN:
• Exercise : Zaznacz pojedyncze ćwiczenie do usunięcia.
• All exerc .: Kasuje wszystkie ćwiczenia.
• Totals: Usuń wartości total: pojedynczo lub wszystkie naraz.

Potwierdź naciskając Yes.
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7. USTAWIENIA

Zmieniaj ustawienia w łatwy sposób, używając oprogramowania ProTrainer 5 W celu uzyskania dalszych
informacji, przejdź do pliku pomocy programu.

Ustawienia ćwiczenia
Wybierz Settings > Exercise

W celu uzyskania dalszych informacji, przejdź doRodzaje ćwiczeń (strona 33).

Ustawienia funkcji
Wybierz Settings > Features.

GPS*
Aktywacja funkcji GPS poprzez wybranie Settings > Features > GPS > On.Teach new sensor? zostanie
wyświetlone.

• Jeżeli sensor został już "nauczony", wybierz No.

• Jeśli Twój sensor nie został jeszcze "nauczony", przejdź doUzywanie nowych akcesoriów (strona 54)aby
uzyskać więcej informacji o "uczeniu" sensorów

* Wymagany jest opcjonalny sensor.

Wysokość
Licznik mierzy i pokazuje informacje o wysokości Zmień ustawienia altimetru w menu Altitude. Możesz
dokonać kalibracji altimetru manualnie lub automatycznie.

Ręczna kalibracja wysokościomierza

Wybierz Settings > Features > Altitude > Calibrate > set the altitude of current location

Jeżeli wysokość, na jakiej przebywasz, różni się znacznie od wyświetlanej na ekranie, Calibrate to xx?

zostanie wyświetlone.

Yes:Altitude calibrated to xx zostanie wyświetlone.

No:Altitude calibration canceled zostanie wyświetlone.

Kalibruj wysokość, aby być pewnym, że wskazania są poprawne. Wprowadź odpowiednią wysokość
zawsze, gdy znajdujesz się w miejscu o oznaczonej wysokości np. na szczycie górskim lub na poziomie
morza.

Automatyczna kalibracja wysokościomierza

Wybierz Settings > Features > Altitude > AutoCalib > On / Off

Używając opcji automatycznej kalibracji, możesz dopasować początkowy poziom aby był zawsze taki
sam na początku ćwiczenia. Skalibruj poziom manualnie i włącz automatyczną kalibrację (AutoCalib). Od
tej chwili, ten poziom będzie zawsze używany jako podstawowa wysokość na początku ćwiczenia, gdy
włączona jest automatyczna kalibracja. Również, jeśli automatyczna kalibracja jest włączona i
skalibrujesz licznik manualnie, to nowa wartość będzie użyta jako poziom początkowy dla opcji
automatycznej kalibracji.
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Jeśli poziom ćiśnienia znacząco się zmieni, to zostaniesz poproszony o potwierdzenie zmiany. Jeśli
zmieniłeś poziom,to Altitude calibrated to xx m/ft wskaże, że kalibracja się powiodła.Jeśli Altitude

calibration failed zostanie wyświetlone, przekalibruj wysokościomierz.

Możesz również ustawić poziom wysokości dla automatycznej kalibracji używając oprogramowania
ProTrainer 5 Aby uzyskać więcej informacji, przeczytaj pomoc oprogramowania.

Wybierz tę opcję jeśli ćwiczysz w takich samych warunkach. W ten sposób zapewnisz poprawne wskazania
wysokości.
Jeśli profil sportowy ćwiczenia zawiera automatyczną kalibrację, to wysokościomierz zawsze będzie zaczynać
na tym poziomie; bez względu na główne ustawienie poziomu.

Zapis tempa (uśrednianie)
Uśrednianie w liczniku jest ustawione domyślnie na 5 sekund Możesz zmienić częstotliwość uśredniania
w Settings > Features > Rec.rate > 1 / 2 / 5 / 15 / 60 sec.

Polar może przechowywać tętno, prędkość, kadencję, moc oraz wysokość w 1, 2, 5, 15 i 60 sekundowym
uśrednianiu. Długi czas uśredniania pozwala na dłuższy zapis, natomiast krótki czas uśredniania pozwala
uzyskać bardziej szczegółowe dane. Umożliwia to dokładniejszą analizę w oprogramowaniu ProTrainer
5.

Krótszy czas uśredniania potrzebuje więcej pamięci przez co będzie ona szybciej wykorzystana W
trakcie ustawiania czasu uśredniania pozostały czas zapisu wyświetlony jest w dolnym rzędzie.
Domyślny czas uśredniania wynosi 5 sekund

Gdy zostanie mniej niż 30 minut maksymalnego czasu zapisu, czas uśredniania zostanie automatycznie
przedłużony (1s > 2s > 5s > 15s > 60s). Zmaksymalizuje to czas zapisu ćwiczenia. Gdy sesja się
skończy, aktualne uśrednianie będzie użyte w kolejnych sesjach treningowych

Poniższa tabela przedstawia czas zapisu w zależności od czasu uśredniania. Maksymalny czas zapisu
może być krótszy, jeśli zapisałeś dużą liczbę krótkich ćwiczeń

Uśrednianie zmieni się gdy pozostanie mniej niż 30 minut wolnej pamięci. Memory low zostanie wyświetlone
gdy zostanie 60 minut wolnej pamięci.

Zapis RR Prędkość Kadencja Moc GPS Zapis tempa (uśrednianie)

1s 2s 5s 15s 60s

Off Off Off Off Off 22h
30min

45h
00min

112h
40min

338h
10min

1352h
55min

Off Off Off On Off 9h
30min

19h 10
min

48h
10min

144h
50min

579h
40min

Off Off On Off Off 16h
50min

33h
40min

84h
30min

253h
40min

1014h
40min

Off Off On On Off 8h
20min

16h
50min

42h
10min

126h
50min

507h
20min

Off On Off Off Off 11h
10min

22h
30min

56h
20min

144h
50min

579h
40min

Off On Off Off On 4h
40min

9h
30min

24h
00min

67h
30min

270h
30min

Off On Off On Off 6h
40min

13h
30min

33h
40min

92h
10min

368h
50min

POLSKI

34 Ustawienia



Zapis RR Prędkość Kadencja Moc GPS Zapis tempa (uśrednianie)

1s 2s 5s 15s 60s

Off On Off On On 3h
40min

7h
30min

18h
40min

53h
20min

213h
30min

Off On On Off Off 9h
30min

19h 10
min

48h
10min

126h
50min

507h 20
min

Off On On Off On 4h 30
min

9h 00
min

22h
30min

63h
20min

253h
40min

Off On On On Off 6h
00min

12h
10min

30h
40min

84h
30min

338h
10min

Off On On On On 3h
30min

7h
00min

17h
40min

50h
40min

202h
50min

On Off Off Off Off 18h
20min

25h
20min

32h
40min

37h
30min

39h
50min

On Off Off On Off 8h
40min

14h
20min

23h
30min

32h
40min

38h
20min

On Off On Off Off 14h
20min

21h
20min

29h
50min

36h
10min

39h
20min

On Off On On Off 7h
40min

13h
00min

22h
00min

31h
40min

38h
00min

On On Off Off Off 10h 00
min

16h 10
min

25h
20min

32h
40min

38h
20min

On On Off Off On 4h 30
min

8h
10min

15h
50min

26h
00min

35h
40min

On On Off On Off 6h
20min

10h
50min

19h 30
min

29h
00min

36h
50min

On On Off On On 3h
30min

6h
30min

13h
20min

23h
30min

34h
20min

On On On Off Off 8h
40min

14h
20min

23h
30min

31h
40min

38h
00min

On On On Off On 4h
10min

7h
40min

15h
00min

25h
20min

35h
10min

On On On On Off 5h
40min

10h 00
min

18h
20min

28h
10min

36h
30min

On On On On On 3h
20min

6h
20min

12h
50min

23h 00
min

34h 00
min

Czas w tabeli jest szacowany. Dla RR data, maksymalny czas zapisu zależy od tętna i jego wahań. Jeśli
zapisujesz okrążenia i/lub tworzysz ćwiczenie, które zawiera fazy za pomocą ProTrainera 5, to maksymalny
czas zapisu się zmniejszy.

Funkcja RR Data
Wybierz Settings > Features > RR Data > On / Off
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Funkcja zapisu RR mierzy i zapisuje interwały pomiędzy uderzeniami serca w milisekundach. Umożliwia
to analizę wariacji tętna (HRV) za pomocą oprogramowania Polar ProTrainer 5. Funkcja zapisu RR
zużywa pamięć licznika, a gdy ustawiana jest ta opcja, to pozostały do wykorzystania czas zapisu pokaże
się w dolnej linii wyświetlacza.

Automatyczny zapis okrążeń
Ustawienie automatycznego zapisu okrążeń

Wybierz Settings > Features > A.Lap > On > set the lap distance

Licznik automatycznie zapisze okrążenia. Wybierz Off aby deaktywować.

Wyświetlanie tętna
Wybierz sposób wyświetlania tętna.

Wybierz Settings > Features > HR view > HR / HR% / HRR%

Sport zones
Ustaw strefy w odbiorniku

Wybierz Settings > Features > Sport zones > Sport zone low limit

Ustaw dolny limit sport zone 1 przez naciśnięcie UP lub DOWN. Następnie wciśnij OK. W ten sam
sposób ustaw dolny limit dla każdej ze stref. Podczas ustawienia dolnego limitu, górny limit poprzedniej
strefy wyznaczany jest automatycznie.

Przytrzymaj LIGHT aby przełączać pomiędzy wyświetlaniem stref: HR% (procent z maksymalnego tętna)
BMP (uderzenia serca na minutę) lub HRR% (procent z rezerwy tętna).

Zmieniaj ustawienia w łatwy sposób używając oprogramowania ProTrainer 5 W celu uzyskania dalszych
informacji, przejdź do pliku pomocy programu.

Możesz zablokować lub odblokować strefy poprzez przytrzymanie przycisku LAP podczas jazdy.

Ustawienia rowerowe.
Wybierz Settings > Bike

Możesz wybrać ustawienia dla trzech rowerów. Przygotuj ustawienia dla rowerów, a gdy zaczynasz
trening, wybierz rower 1, 2 lub 3. Bike 1 jest ustawiony domyślnie.

Wybierz Settings > Bike > Bike 1, Bike 2, Bike 3 lub Other.Bike 2 i Bike 3 mogą być włączone lub
wyłączone. Wybierz Other aby wyłączyć prędkość, kadencję i sensor pomiaru mocy i zacząć tylko pomiar
tętna, wysokości, temperatury i dane z sensora GPS.

Rozmiar koła
Wybierz Bike > Bike 1 > Wheel

Podanie prawidłowego rozmiaru koła jest niezbędne do poprawnych wskazań. W celu uzyskania
dalszych informacji o pomiarze rozmiaru koła, przejdź doPomiar rozmiaru koła. (strona 7).

(Prędkość)Speed: On / Off
Docelowo prędkość jest Off (wyłączona) dla bike 1.

Aby aktywować sensor prędkości w liczniku, wybierz Settings > Bike > Bike 1 > Speed > On.Teach new
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sensor? zostanie wyświetlone.

• Jeżeli sensor został już "nauczony", wybierz No.

• Jeśli twój sensor nie został jeszcze "nauczony", przejdź doUzywanie nowych akcesoriów (strona 54)aby
uzyskać więcej informacji o "uczeniu" sensorów

Ustawienia prędkości mogą być ustawione manualnie lub za pomocą ProTrainera 5.

Czas przyjazdu.
Wybierz Settings > Bike > Bike 1 > Arr. time

Ustaw dystans, który zamierzasz przejechać, a Polar wyliczy i wyświetli przewidywany czas przyjazdu -
bazując na prędkości jazdy. Zamontuj sensor prędkości Polara w celu mierzenia prędkości i dystansu. W
celu uzyskania dalszych informacji o montażu sensora prędkości, przejdź do instrukcji sensora.

• Wybierz naciskając OK

• Wybierz On/Off aby włączyć lub wyłączyć opcję.

• Wybierz Set dist. aby ustawić dystans, który masz zamiar przejechać.

Autostart: On / Off
Wybierz Settings > Bike > Bike 1 > Autostrt.

Funkcja Autostart rozpoczyna i kończy zapis ćwiczenia automatycznie, gdy zaczynasz lub kończysz
jazdę Funkcja Autostartu wymaga sensora kadencji Polar Speed Sensor W.I.N.D.

Power*(moc): On / Off
Możesz zamontować opcjonalny sensor pomiaru mocy na rowerze.

Aby aktywować sensor prędkości w liczniku, wybierz Settings > Bike > Bike 1 > Power > On.Teach new

sensor? zostanie wyświetlone.

• Jeżeli sensor został już "nauczony", wybierz No.

• Jeśli Twój sensor nie został jeszcze "nauczony", przejdź doUzywanie nowych akcesoriów (strona 54)aby
uzyskać więcej informacji o "uczeniu" sensorów

Power settings : Musisz wprowadzić wagę łańcucha (g), długość (mm) oraz odległość między osią tylnego
koła a osią supportu (mm) do licznika by zapewnić dokładne wskazania mocy.

Wybierz Settings > Bike > Bike1, Bike 2 or Bike 3 > Power > Settings i

> Set chain weight (waga #a#cucha) xxxx g > OK

> Set chain length (d#ugo## #a#cucha) xxx mm > OK

> Set chain length (d#ugo## #a#cucha) xxx mm > OK

W celu uzyskania dalszych informacji o ustawieniach sensora mocy, przejdź do instrukcji sensora
pomiaru mocy.

Możesz użyć oprogramowania ProTrainer 5 w celu ustawienia sensora mocy.

*Opcjonalny sensor jest wymagany.

(Kadencja) Cadence*: On / Off
Możesz zamontować opcjonalny sensor kadencji na rowerze.
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Aby aktywować sensor kadencji w liczniku, wybierz Settings > Bike > Bike 1 > Cadence > On. Teach new

sensor? zostanie wyświetlone.

• Jeżeli sensor został już "nauczony", wybierz No.

• Jeśli Twój sensor nie został jeszcze "nauczony", przejdź doUzywanie nowych akcesoriów (strona 54)aby
uzyskać więcej informacji o "uczeniu" sensorów

Ustawienia użytkownika
Upewnij się, że wprowadziłeś poprawne dane o użytkowniku, aby otrzymywać jak najdokładniejsze dane
o postępie treningu.

Aby ustawić dane o użytkowniku, wybierz Settings > User

• Weight: (waga) Aby zmienić jednostki, wciśnij i przytrzymaj LIGHT
• Weight: (waga) Aby zmienić jednostki, wciśnij i przytrzymaj LIGHT
• Birthday: (data urodzenia) dd=dzień, mm=miesiąc, yy=rok
• Sex: (płeć) Male/Female (Mężczyzna/Kobieta)
• Activity: Top/High/Moderate/Low
• Heart Rate : HRmax, HRsit

• VO2max: Maksymalna ilość tlenu przyswajana przez organizm

Stopień Aktywności

Stopień aktywności to ocena własnej aktywności fizycznej. Wybierz stopień najlepiej opisujący twoją
aktywność fizyczną w ostatnich trzech miesiącach.
• Top: Ćwiczysz ciężko przynajmniej 5 razy w tygodniu lub trenujesz z założeniem maksymalizacji

wyników
• High (wysoka): 3-5 godzin tygodniowo. Ćwiczysz co najmniej 3 razy w tygodniu z dużym obciążeniem,

na przykład biegasz 20-50 km tygodniowo lub spędzasz 3-5 godzin tygodniowo uprawiając sport o
podobnym obciążeniu.

• Moderate (średnia): 1-3 godzin tygodniowo.Regularnie uprawiasz sport, na przykład biegasz 5-10 km
tygodniowo lub spędzasz 1-3 godzin tygodniowo uprawiając sport o podobnym obciążeniu lub twoja
praca wymaga wysiłku fizycznego.

• Low (niska): 0-1 godzin tygodniowo.Jeśli nie ćwiczysz regularnie / brak ci ciężkiego wysiłku
fizycznego; na przykład spacerujesz dla przyjemności lub ćwiczysz tylko okazjonalnie (lecz na tyle
intensywnie aby przyspieszyć tętno / oddech).

W liczniku, te wartości są używane do wyliczenia wydatku energetycznego.

Heart Rate: HRmax, HRsit
HRmax (maksymalne tętno): jako domyślne ustawione jest HRmax (220 - wiek) ustalone na podstawie
wieku. Aby ustawić manualnie HRmax, powinieneś znać jego wartość wyliczoną laboratoryjnie, lub za
pomocą Fitness testu w Polarze CS600X, lub - jeśli samemu wyznaczyłeś tę wartość.

HRsit (wartość tętna spoczynkowego): Wartość domyślna HR sit jest wyznaczana na podstawie wieku.
Ustaw wartość swojego HRsit jeśli już go wyznaczyłeś zgodnie z instrukcją. Aby zobaczyć instrukcję,
przejdź doTętno spoczynkowe (strona 58)Informacja w tle

Maksymalna ilość tlenu przyswajana przez organizm: VO2max
VO2max jest to maksymalna ilość tlenu, jaka może być przyswojona, podczas maksymalnego wysiłku,
przez organizm. Najbardziej dokładny sposób na wyznaczenie VO2max to test przeprowadzony przy
najwyższym wysiłku. Jeśli znasz dokładną wartość VO2max zmierzoną laboratoryjnie, to możesz ją
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wprowadzić manualnie. W przeciwnym wypadku, zmierz porównywalną wartość, OwnIndex, wykonując
Polar Fitness Test™. Celem uzyskania dalszych informacji, przejdź do Polar Fitness Test™ (strona 46).

Jeżeli zmienione zostaną ustawienia użytkownika, User settings updated zostanie wyświetlone.

Możesz wprowadzać i edytować dane o użytkowniku używając ProTrainera 5. W celu uzyskania dalszych
informacji, przejdź do pliku pomocy programu.

Ustawienia podstawowe

Dźwięk
Wybierz Settings > General > Sound

Głośność
Wybierz Settings > General > Sound > Volume > On / Off

Ustaw poziom dźwięku przycisków oraz potwierdzeń podczas ćwiczenia Ustawienie to nie ma wpływu na
funkcje budzika i alarmu przekroczenia stref (TZ Alarm).

TZ Alarm (Alarm przekroczenia stref)
Możesz włączyć lub wyłączyć TZ Alarm:

Wybierz Settings > General > Sound > TZ Alarm > On / Off

Jeśli alarm stref jest wyłączony, to wskaźnik tętna będzie migać po przekroczeniu wyznaczonej strefy.

Blokada przycisków
Aby zmienić ustawienia blokady przycisków

Wybierz Settings > General > Keylock > Manual / Automatic

Blokada przycisków chroni przed ich przypadkowym przyciskaniem.

Manual: Ręczne aktywowanie blokady klawiszy.

Automatic: Blokada klawiszy jest aktywowana automatycznie wówczas, gdy na ekranie aktualnego czasu
nie używano przycisków przez co najmniej minutę

Aby włączyć lub wyłączyć blokadę (On/Off), przytrzymaj LIGHT przez przynajmniej jedną minutę i wciśnij
OK.

Jednostki
Ustaw w liczniku preferowane jednostki

Wybierz Settings > General > Units > kg/cm/km or lb/ft/mi

Język
Wybór języka

Wybierz Settings > General > Language > English / Deutsch / Español / Français / Italiano

(Uśpienie) Sleep
Aktywuj funkcję sleep

Wybierz Settings > General > Sleep > Activate sleep mode? > Yes
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Aktywacja trybu uśpienia spowoduje mniejszy pobór napięcia z licznika, a co za tym idzie bateria nie
będzie się tak szybko rozładowywać, jeśli nie będziesz używać Polara przez dłuższy czas. Działanie
budzika jest niezależne od aktywacji funkcji sleep.

Aby ponownie włączyć licznik

Wciśnij jakikolwiek przycisk > Turn display on? > Yes / No

Yes: licznik zostanie aktywowany.

No: licznik powróci do trybu uśpienia.

Ustawienia zegarka

Przypomnienia
Ustawienie przypomnienia dla różnych zadań lub ćwiczeń

Wybierz Settings > Watch > Reminders > Add new

Date: Wprowadź datę zdarzenia, dd=dzień, mm=miesiąc, yy=rok.

Reminder time : Wprowadź czas przypomnienia.

Alarm: Ustaw alarm na konkretną godzinę, lub na 10 min / 30 min / 1 godzinę przed wydarzeniem.

Sound: Wybierz typ alarmu Cichy / Sygnał / Normalny.

Repeat : Wybierz częstotliwość zdarzenia Raz / Co godzinę / Codziennie / Tygodniowo / Miesięcznie /
Rocznie.

Exercise : Wybierz ćwiczenie, które chcesz mieć przypominane. Gdy przypomnienie zostanie wyłączone,
licznik będzie przedstawiać to ćwiczenie jako domyślne. Wybierz NONE jeśli nie chcesz przy danym
ćwiczeniu skorzystać z opcji przypomnienia.

Rename: Aby zmienić nazwę wydarzenia, wybierz litery przy pomocy UP lub DOWN i zatwierdzaj je
przyciskiem OK.

Możesz ustawić siedem przypomnień w liczniku.

Aby przeglądać aktywne przypomnienia i je modyfikować:

Wybierz Settings > Watch > Reminders

Wybierz przypomnienie, które chcesz obejrzeć, edytować lub usunąć.

Wydarzenie
By ustawić odliczanie do wydarzenia

Wybierz Settings > Watch > Event

Event day: dd=dzień, mm=miesiąc.

Rename: Aby zmienić nazwę wydarzenia, wybierz litery przy pomocy UP lub DOWN i zatwierdzaj je
przyciskiem OK.

Aby zmienić ustawienia odliczania
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Wybierz Settings > Watch > Event

Można zobaczyć czas do wydarzenia, zmienić jego datę, nazwę lub go usunąć.

Na ekranie z godziną, poprzez wciśnięcie i przytrzymanie przycisku UP, możesz ponownie schować lub
wyświetlić odliczanie.

Alarm
Ustawienie alarmu w liczniku

Wybierz Settings > Watch > Alarm > Off / Once / Mon-Fri / Daily

Możesz ustawić alarm aby zadziałał raz (Once), codziennie od poniedziałku do piątku (Mon-Fri),
codziennie (Daily) lub możesz go wyłączyć Off. Alarm będzie dzwonić we wszystkich trybach, za
wyjątkiem trybu ćwiczenia; będzie dzwonić przez minutę, chyba, że naciśniesz STOP. Alarm działa
również w trybie uśpienia oraz gdy dźwięki są wyłączone w ustawieniach ogólnych General .

Aby ustawić drzemkę na dodatkowe 10 minut, wciśnij UP , DOWN lub OK: Snooze zostanie wyświetlone i
rozpocznie się odliczanie drzemki. Aby wyłączyć drzemkę, wciśnij STOP.

Jeżeli na wyświetlaczu pojawi się symbol baterii, budzik nie będzie aktywowany

Czas
Ustaw time 1 w liczniku

Wybierz Settings > Watch > Time 1 > 24h / 12h

Ustaw time 2 w liczniku

Wybierz Settings > Watch > Time 2

Ustaw pożądaną różnicę pomiędzy Time 1 a Time 2 w godzinach za pomocą przycisków UP/ DOWN.

Time zone (strefa czasowa)
Przełączanie pomiędzy ustawionymi godzinami

Wybierz Settings > Watch > Time zone > Time 1 / Time 2

Wybierz strefę czasową

Na ekranie głównym; zmień strefę czasową poprzez wciśnięcie i przytrzymanie DOWN. Wyświetlanie
czasu 2 sygnalizuje numer 2 w prawym dolnym rogu ekranu.

Data
Aby ustawić datę w liczniku

Wybierz Settings > Watch > Date

dd=dzień, mm=miesiąc, yy=rok

Zmieniaj ustawienia w łatwy sposób używając oprogramowania ProTrainer 5 Więcej informacji znajdziesz
w pomocy programu.

Szybkie wybieranie (Quick Menu)
Niektóre funkcje można wybrać poprzez skrót klawiszowy z menu głównego.

Przytrzymaj LIGHT > Quick menu

• Keylock

• Przypomnienia

• Alarm
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• Strefa czasowa

• Sleep
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8. PROGRAM TRENINGOWY

Przeglądanie programu
Twórz i ściągaj spersonalizowane programy treningowe do licznika za pomocą oprogramowania Polar
ProTrainer 5. Ten rozdział zawiera podstawowe informacje o tym jak kierować i zarządzać programem po
tym jak już został pobrany do licznika. W celu uzyskania dalszych informacji o tworzeniu planów
treningowych za pomocą oprogramowania, przesyłaniu ich do licznika i analizowaniu wydajności po
treningu, przejdź do pliku pomocy programu.

Po pobraniu programu treningowego, pojawią się dwa dodatkowe menu w liczniku, gdzie będziesz mógł
przeglądać swój program i sprawdzać dzienny rozkład. Przewijaj tygodnie, dni i ćwiczenia za pomocą UP
lub DOWN. Wybierz tygodnie i dni za pomocą OK.

Aby przeglądnąć program tygodniowy

Wybierz Program > Week view

Week view umożliwia przejrzenie ćwiczeń z danego tygodnia. Biały kolor słupka prezentuje planowany
czas ćwiczenia, czarny kolor - czas przeprowadzonego ćwiczenia . Poniżej słupków pokazany jest
docelowy czas ćwiczeń danego tygodnia.

Wciśnij i przytrzymaj LIGHT aby przeglądać następujące informacje tygodniowe.
• Week info: Opis i nazwa tygodnia.
• Targets: Podsumowanie założeń tygodniowych. Kalorie, dystans i czas trwania ćwiczenia. Planowany

czas dla stref: wciśnij OK i przewijaj pomiędzy strefami za pomocą UP lub DOWN.
• Results: Podsumowanie rezultatów danego tygodnia. Kalorie, dystans i czas trwania ćwiczenia.

Planowany czas dla stref: wciśnij OK i przewijaj pomiędzy strefami za pomocą UP lub DOWN.
• Reminder : Ustaw alarm (na określoną godzinę, 10 min, 30 min lub 60 minut przed ćwiczeniem) oraz typ

dźwięku (Cichy, Sygnał, Normalny).
• Program off : Usuwa program z licznika.

Aby przeglądnąć program tygodniowy

Wybierz Program > Week view > Day view

Wybierz Today > Exercise view

Day view umożliwia przejrzenie ćwiczeń z danego dnia. Biały kolor słupka prezentuje planowany czas
ćwiczenia, czarny kolor - czas przeprowadzonego ćwiczenia . Poniżej słupków pokazany jest docelowy
czas ćwiczeń danego dnia.

Wciśnij i przytrzymaj LIGHT aby zobaczyć dodatkowe informacjie o dniu:
• Targets: Podsumowanie założeń dziennych. Kalorie, dystans i czas trwania ćwiczenia. Planowany czas

dla stref: wciśnij OK i przewijaj pomiędzy strefami za pomocą UP lub DOWN.
• Results: Podsumowanie rezultatów danego dnia. Kalorie, dystans i czas trwania ćwiczenia. Planowany

czas dla stref: wciśnij OK i przewijaj pomiędzy strefami za pomocą UP lub DOWN.
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Podgląd ćwiczeń z danego dnia

Wybierz Program > Week view > Day view >Exercise view

Wyświetlona zostanie nazwa, opis i docelowy czas trwania ćwiczenia.

Wciśnij i przytrzymaj LIGHT aby przeglądać następujące informacje:
• Targets: Podsumowanie założeń dla sesji treningowej. Kalorie, dystans i czas trwania ćwiczenia.

Planowany czas dla stref: wćiśnij OK i przewijaj pomiędzy strefami za pomocą UP lub DOWN.
• Phases: Podsumowanie faz podczas sesji treningowej.
• Sport profile: Przeglądaj nazwę wybranego profilu. W celu uzyskania dalszych informacji, przejdź do

pliku pomocy ProTrainera 5
• Reminder : Ustawienie czasu przypomnienia.

Wykonywanie Zaprogramowanych Ćwiczeń

Rozpoczęcie ćwiczenia
Jeśli ustawiłeś przypomnienie, licznik da ci znać aby ćwiczyć zgodnie z planem założonym na dany
dzień. Przeglądaj informacje o zaplanowanym ćwiczeniu naciskając OK gdy przypomnienie się wyłączy.

Rozpoczęcie dziennego ćwiczenia

Wybierz Today > Exercise view (nazwa ćwiczenia) > OK

Wybierz Program > Week view > Day view >Exercise view > OK > OK

Aby uzyskać więcej informacji na temat zapisywania ćwiczeń, przejdź doRozpoczęcie treningu
(strona 15). Twój Polar przeprowadzi cię przez sesję treningową..

Ćwiczenie z fazami
Poniżej znajduje się przykład ćwiczenia interwałowego, składającego się z 4 faz:

Warm up / P1: Jedź przez 15 minut z tętnem w przedziale 60-70% tętna maksymalnego.

Interval / P2: Jedź 5 km z tętnem w przedziale 80-90% tętna maksymalnego.

Odnowa / P3: Jedź 5 minut z tętnem w przedziale 55-65% tętna maksymalnego. Powtórz fazę 2 i 3 po
trzy razy.

Odpoczynek / P4: Jedź 15 minut z tętnem w przedziale 55-65% tętna maksymalnego.

Wygląd ekranu podczas ćwiczenia
Podczas ćwiczenia ekran może wyglądać następująco:

Każda faza rozpoczyna się ekranem, na którym zawarte są:
Nazwa fazy
Zone type (Typ Strefy)
Limity strefy

Podczas ćwiczenia, wyświetlacz faz pokazuje :
Odliczenie czasu/dystansu, timer odliczenia, liczbę aktualnych faz
Strefa docelowa jako wykres (odświeżany co 10 sek, obrazujący ostatnie 8 minut
ćwiczenia)
Tętno
Ilość powtórzeń pozostałych do realizacji
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Każda faza kończy się wyświetleniem następujących informacji:
Czas trwania fazy lub dystans
Różnice w tętnie (o ile zwiększyło się i zmniejszyło tętno podczas danej fazy) lub
średnia prędkość
Tętno średnie
Numer zakończonej fazy

Gdy zaprogramowane ćwiczenie się zakończy, wyświetlona zostanie informacja o
tym, że ćwiczenie przebiegło pomyślnie, Ride 1 completed zostanie wyświetlone.
Licznik przejdzie do trybu ćwiczenia Free i będziesz mógł kontynuować jazdę bez
ustawień. Ćwiczenie jest zapisywane

W celu uzyskania dalszych informacji o tworzeniu planów treningowych za pomocą oprogramowania i
przesyłaniu ich do licznika, przejdź do pliku pomocy programu.

Funkcje, dostępne podczas ćwiczenia
Zmieniaj te same ustawienia ćwiczeń w zaprogramowanym ćwiczeniu co w każdym innym typie treningu.
Aby uzyskać więcej informacji o dostępności różnych funkcji podczas ćwiczeń, przejdź doFunkcje
przycisków (strona 20).

Zaprogramowane ćwiczenie używa ustawień profilu w oprogramowaniu ProTrainer 5. Jeśli zmienisz
ustawienia licznika podczas ćwiczenia (n.p. HR view), to zmiany zostaną wprowadzone do aktualnego
ćwiczenia. Przy następnym rozpoczęciu tego samego treningu, licznik użyje ustawień profilu
zdefiniowanych w oprogramowaniu.

(Menu okrążeń) Lap menu
Aby wyświetlić menu okrążeń podczas zaprogramowanego ćwiczenia, przytrzymaj OK. Przewijaj między
opcjami za pomocą UP lub DOWN ; wybierz używając OK. Zawartość Lap Menu jest uzależniona od
twojego ćwiczenia

• End phase: Kończy aktualną fazę ćwiczenia i przechodzi do kolejnej.

• Jump to: Przejdź do którejkolwiek fazy ćwiczenia.

Aby przeglądać wyniki ćwiczenia, wybierz File > Exercise log

Po zakończeniu zaprogramowanego ćwiczenia, pliki zostaną zapisane w folderze File.Celem uzyskania
dalszych informacji, przejdź do Analiza wyników ćwiczenia (strona 24).
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9. TESTY

Polar Fitness Test™
Wybierz Test > Fitness

Polar Fitness Test # jest łatwym i szybkim sposobem na zmierzenie wydajności organizmu podczas
spoczynku. Wynik testu nazywany jest OwnIndex. OwnIndex jest porównywalny do maksymalnego
pułapu tlenowego (VO2max), który jest przyjęty jako pomiar wydolności tlenowej, wykorzystywanej przy
określeniu sprawności fizycznej. Na twój wynik testu OwnIndex mają wpływ: poziom aktywności fizycznej
(w skali długoterminowej), tętno, wahania tętna w stanie spoczynku, płeć, wiek, wzrost oraz waga. Polar
Fitness Test jest przeznaczony dla zdrowych osób dorosłych.

Pozwala on ocenić zdolność organizmu oraz szybkość, z jaką tlen transportowany jest do mięśni. Im
lepsza wydajność tlenowa, tym silniejsze i wydajniejsze jest twoje serce. Wysoka wydajność tlenowa
korzystnie wpływa na zdrowie. Przykładowo; pomaga obniżyć wysokie ciśnienie krwi zmniejszając tym
samym ryzyko problemów zdrowotnych z nim związanych. Jeżeli chcesz zwiększyć swoją wydajność
tlenową, musisz ćwiczyć regularnie, średnio 6 tygodni (wpłynie to zauważalnie na OwnIndex). Osoby
mniej wytrenowane zauważą zmiany jeszcze szybciej. Im lepszą masz kondycję, tym wolniej zauważysz
zmiany OwnIndexu.

Najszybszy wzrost wydolności tlenowej następuje podczas uprawiania sportów angażujących duże partie
mięśni. Są to m.in bieganie, kolarstwo, chód, pływanie, jazda na rolkach i łyżwach, narciarstwo biegowe.

Rozpoczynając pomiar, w ciągu pierwszych 2 tygodni wyznacz OwnIndex kilkakrotnie; uśredniając wyniki
wyznaczysz poziom wyjściowy. Potem OwnIndex można wyznaczać mniej więcej raz na miesiąc.

Dzięki Polar Fitness Test możesz również obliczyć maksymalną, przewidywalną pracę serca (HR max-p).
Wynik HRmax-p określa maksymalne tętno bardzie precyzyjnie niż formuła bazująca na wieku (220 -
wiek). Aby uzyskać więcej informacji na temat HRmax, przejdź doUstawienia użytkownika (strona 38).

Aby pomiar był optymalny, musisz spełnić następujące warunki:
• Test można wykonać gdziekolwiek (dom, praca, siłownia) pod warunkiem, że nic nie będzie cię

rozpraszać. Nie ma żadnych niepokojących dźwięków (np. telewizja, radio, telefon), z nikim nie
rozmawiasz.

• Zawsze wykonuj test w tych samych warunkach i o tej samej porze.
• Unikaj ciężkich posiłków i nie pal na 2-3 godziny przed rozpoczęciem testu.
• Zarówno dzień wcześniej jak i w dniu, podczas którego przeprowadzasz test, unikaj stresu, alkoholu oraz

zażywania zbędnych lekarstw.
• Zrelaksuj się i wycisz. Połóż się i wycisz na 1-3 minut przed testem.

Przed wykonaniem testu
Załóż nadajnik

Celem uzyskania dalszych informacji, przejdź do Zakładanie nadajnika (strona 13).

Wprowadź dane o użytkowniku

Wybierz Settings > User

Aby przeprowadzić Polar Fitness Test, wprowadź dane o użytkowniku (jeśli wprowadziłeś je już
wcześniej to nie ma takiej potrzeby) i poziom długoterminowej aktywności fizycznej wUstawienia
użytkownika (strona 38).
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Włącz HRmax-p

Jeżeli chcesz otrzymać wartość przewidywalnego tętna maksymalnego, włącz HRmax-p.

Wybierz Test > Fitness > HR max -p > On

Przeprowadzenie testu
Wybierz Test > Fitness > Start > Fitness Test Lie Down

Fitness test rozpocznie się za 5 sekund. Strzałki oznaczają rozpoczęcie testu.. Zrelaksuj się; ogranicz
ruchy ciała oraz komunikację z inymi osobami.

Jeżeli w ustawieniach użytkownika nie wpisałeś długoteminowego poziomu aktywności fizycznej, Set

your personal activity level zostanie wyświetlone. Wybierz Top, High, Moderate , lub Low. W celu
uzyskania dalszych informacji o poziomach aktywności fizycznej, przejdź do User Settings

Jeśli licznik nie odbiera tętna na początku lub podczas testu, to test nie przebiegł pomyślnie i zostanie
wyświetlony komunikat Test failed, check WearLink . Sprawdź wówczas czy elektrody są dobrze zwilżone i
czy dokładnie przylegają do ciała; rozpocznij test ponownie.

Podwójny sygnał dźwiękowy poinformuje cię o zakończeniu testu. OwnIndex wyświetlany jest jako wartość
numeryczna oraz stopień oszacowania. Aby uzyskać więcej informacji na temat oszacowań, przejdź do
Klasyfikacja poziomu wytrenowania organizmu.

Aby wyświetlić wartość Przewidywanego t#tna maksymalnego wciśnij DOWN. Wciśnij OK aby wyjść.

Update to VO2 max? zostanie wyświetlone.
• Wybierz Yes aby zapisać wartość OwnIndex w ustawieniach użytkownika oraz Fitness Test Trend menu.
• Wybierz No tylko wówczas, gdy znasz swoje, przebadane, VO2max , oraz gdy różni się ono więcej niż

jeden stopień wytrenowania od wyniku OwnIndex. Wartość twojego OwnIndex jest zapisana tylko do
menu Fitness Test Trend. Celem uzyskania dalszych informacji, przejdź do Fitness Test Trend .

Uaktualni# HR max? (if HRmax-p(if HRmax-p is on) jest wyświetlone.
• Wybierz Yes aby zapisać wartość do ustawień użytkownika.
• Wybierz No w przypadku gdy znasz swoje HRmax.

Możesz zatrzymać test w każdej chwili naciskając STOP. Fitness Test canceled zostanie wyświetlone po
kilku sekundach

Zapisane wartości OwnIndex i HRmax-p będą użyte przy obliczaniu spalania kalorii.

Po wykonaniu testu
Klasyfikacja poziomu wytrenowania organizmu

OwnIndex jest najbardziej miarodajny, kiedy porównujemy jego zmiany na przestrzeni czasu. OwnIndex
można też interpretować na podstawie wieku i płci. Zlokalizuj swój OwnIndex w poniższej tabeli i
porównaj swoją wydolność z osobami twojej płci i w twoim wieku.

Najlepsi sportowcy zwykle uzyskują OwnIndex o wartości 70 (mężczyźni) i 60 (kobiety). Uprawiający
sporty wytrzymałościowe na poziomie olimpijskim mogą nawet uzyskać wartość 95. Najwyższy wskaźnik
OwnIndex występuje przy uprawianiu sportów angażujących duże grupy mięśni, takich jak bieganie czy
narciarstwo biegowe.

Mężczyźni

Wiek / Lata Bardzo
słabo

Słabo Dostatecznie Średnio Dobrze Bardzo
dobrze

Celująco

20-24 < 32 32-37 38-43 44-50 51-56 57-62 > 62

25-29 < 31 31-35 36-42 43-48 49-53 54-59 > 59
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Wiek / Lata Bardzo
słabo

Słabo Dostatecznie Średnio Dobrze Bardzo
dobrze

Celująco

30-34 < 29 29-34 35-40 41-45 46-51 52-56 > 56

35-39 < 28 28-32 33-38 39-43 44-48 49-54 > 54

40-44 < 26 26-31 32-35 36-41 42-46 47-51 > 51

45-49 < 25 25-29 30-34 35-39 40-43 44-48 > 48

50-54 < 24 24-27 28-32 33-36 37-41 42-46 > 46

55-59 < 22 22-26 27-30 31-34 35-39 40-43 > 43

60-65 < 21 21-24 25-28 29-32 33-36 37-40 > 40

Kobiety

Wiek / Lata Bardzo
słabo

Słabo Dostatecznie Średnio Dobrze Bardzo
dobrze

Celująco

20-24 < 27 27-31 32-36 37-41 42-46 47-51 > 51

25-29 < 26 26-30 31-35 36-40 41-44 45-49 > 49

30-34 < 25 25-29 30-33 34-37 38-42 43-46 > 46

35-39 < 24 24-27 28-31 32-35 36-40 41-44 > 44

40-44 < 22 22-25 26-29 30-33 34-37 38-41 > 41

45-49 < 21 21-23 24-27 28-31 32-35 36-38 > 38

50-54 < 19 19-22 23-25 26-29 30-32 33-36 > 36

55-59 < 18 18-20 21-23 24-27 28-30 31-33 > 33

60-65 < 16 16-18 19-21 22-24 25-27 28-30 > 30

Klasyfikacja ta powstała w oparciu o przegląd literatury 62 badań, gdzie VO2max było mierzone
bezpośrednio u zdrowych, dorosłych ludzi w USA, Kanadzie oraz w siedmiu krajach Europy. Źródło:
Shvartz E, Reibold RC. Normy sprawności fizycznej dla mężczyzn i kobiet w wieku od 6 do 75 lat:
Omówienie. Aviat Space Environ Med; 61:3-11, 1990.

Fitness Test Trend

Wybierz Test > Fitness > Trend

Zobacz jak wzrasta twoja wartość OwnIndex w menu Trend. Wyświetlane są poszczególne daty i wartości
OwnIndex (maksymalnie 16 wartości). Gdy pliki test trend będą pełne, najstarsze z nich zostaną
automatycznie usunięte.

Wyświetlony zostanie najnowszy pomiar wraz z datą oraz wykres wartości OwnIndex. Przewiń UP lub
DOWN aby przeglądnąć inne wartości.

Usuń wartości OwnIndex.

Wybierz Test > Fitness > Trend

Wybierz wartość, którą chcesz usunąć i przytrzymaj LIGHT > Delete value? No/Yes zostanie
wyświetlone. Potwierdź za pomocą OK.
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Analiza wyników OwnIndex za pomocą programu Polar ProTrainer 5.

Przesłanie rezultatu tętna do ProTrainera 5 umożliwia ci analizę wyników na różne sposoby oraz dostęp
do bardziej szczegółowych informacji o twoich postępach. Oprogramowanie umożliwia również
stworzenie wykresu porównującego wcześniejsze wyniki. Wyniki Polar Fitness Test są przesyłane do
oprogramowania automatycznie wraz z ćwiczeniami, gdy używasz połączenia z monitorem..

Polar OwnOptimizer™

Ogólnie

Efektywny trening wymaga zwiększania: czasu trwania ćwiczenia, intensywności, niekiedy też
całkowitego czasu ćwiczeń w danym okresie. W celu uniknięcia przetrenowania, po każdym ciężkim
treningu musi nastąpić odpowiednio długi odpoczynek. Jeżeli czas odpoczynku będzie niewłaściwy,
możesz doświadczyć spadku formy zamiast jej wzrostu. Polar OwnOptimizer jest prostym i wiarygodnym
testem, który określi czy dany program treningowy optymalnie rozwija twoją formę. Polar OwnOptimizer
mogą wykonać zdrowe osoby dorosłe.

Polar OwnOptimizer jest modyfikacją tradycyjnego testu przetrenowania. Jest to idealne narzędzie
zainstalowane w liczniku dla każdego kto trenuje regularnie przynajmniej trzy razy w tygodniu by
poprawić kondycję albo osiągnąć sportowe cele. Test ten jest oparty na pomiarze tętna i jego wahań
podczas testu ortostatycznego (podnoszenie się z pozycji leżącej do pozycji stojącej). OwnOptimizer
pomaga zoptymalizować obciążenie treningami podczas realizacji programu treningowego tak, aby
następował stały wzrost formy i nie dochodziło do przetrenowania. Polar OwnOptimizer oparty jest na
pomiarze pięciu parametrów tętna. Dwa z nich określane są podczas leżenia, jeden podczas wstawania i
kolejne dwa w pozycji stojącej Za każdym razem jak wykonujesz test, licznik zapisuje wartości tętna i
porównuje je z poprzednimi zapisanymi wartościami.

Przed wykonaniem testu
Baseline Tests

Rozpoczynając OwnOptimizer, aby wyznaczyć indywidualną wartość wyjściową, należy wykonać 6
testów w przeciągu 2 tygodni. Pomiarów tych należy dokonać podczas 2 zwykłych tygodni treningowych
(warunek konieczny: umiarkowany wysiłek). Pomiary powinny być przeprowadzone następnego dnia po
treningu oraz po dniach odpoczynku.

Obserwacja wartości OwnIndexu

Po ustaleniu wartości wyjściowej, test należy wykonywać 2-3 razy w tygodniu. Test wykonuj rano,
pierwszy po dniach odpoczynku, drugi - następnego dnia po ciężkim treningu (lub serii ciężkich
treningów). Trzeci test możesz wykonać rano po dniu, w którym wykonałeś zwykłe ćwiczenie.
OwnOptimizer może okazać się niedokładny zarówno w przypadku przetrenowania jak i bardzo
nieregularnych treningów. Jeżeli przerwa w treningach wyniosła więcej niż 14 dni, ponownie powinieneś
wyznaczyć wartość wyjściową.

Przeprowadzenie testu
W celu uzyskania wiarygodnych wyników, test powinien być przeprowadzany zawsze w podobnych
warunkach. Zaleca się przeprowadzenie testu rano, przed śniadaniem. Podstawowe wymogi dotyczące
przeprowadzenia testu:
• Załóż nadajnik Celem uzyskania dalszych informacji, przejdź do Zakładanie nadajnika (strona 13).
• Zrelaksuj się i wycisz.
• Usiądź wygodnie, lub, jeśli wolisz, połóż się na łóżku. Zawsze wykonuj test w takiej samej pozycji.
• Test można wykonać gdziekolwiek (dom, praca, siłownia) pod warunkiem, że w miejscu tym panuje
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spokój. Nie ma rozpraszających cię dźwięków (np. telewizja, radio, telefon) ani też nikt z tobą nie
rozmawia.

• Unikaj ciężkich posiłków, picia alkoholu oraz palenia na 2-3 godziny przed rozpoczęciem testu.

Przeprowadzenie testu

Wybierz Test > Optimizer > Start > Optimizer Lie Down

Strzałki wskazują rozpoczęcie testu. Nie ruszaj się podczas pierwszych 3 minut testu.

Po 3 minutach licznik da sygnał dźwiękowy i zostanie wyświetlony komunikat Optimizer Stand up . Wstań i
stój nieruchomo przez 3 minuty.

Po 3 minutach, licznik ponownie da sygnał dźwiękowy i test zostanie zakończony.

Wynik pojawi się jako numer wraz z jego interpretacją. Wciśnij DOWN aby zobaczyć średnie tętno (bpm)
podczas leżenia (HRrest), najwyższe tętno podczas wstawania (HRpeak) oraz średnie tętno w pozycji
stojącej (HRstand).

Wykonywanie testu możesz przerwać w dowolnej fazie, naciskając STOP. Optimizer Test canceled

zostanie wyświetlone.

Jeśli licznik nie mógł odczytać tętna, zostanie wyświetlony komunikat Test failed. Check WearLink

zostanie wyświetlone. W tej sytuacji powinieneś sprawdzić czy elektrody są dobrze zwilżone oraz czy
dokładnie przylegają do ciała.

Po wykonaniu testu
Jak interpretować wyniki

Polar wylicza pięć parametrów bazujących na tętnie i jego zmienności. Wartość OwnOptimizer jest
obliczana poprzez porównanie otrzymanych wyników z poprzednimi. Polar wyświetli opis o statusie
twojego treningu. Rozwinięcia tych opisów są przedstawione poniżej.

Good Recovery (1)

Twoje tętno jest niższe niż zwykle. Oznacza to, że bardzo dobrze się zregenerowałeś. Możesz
kontynuować trening, wykonując nawet intensywne ćwiczenia.

Normal State (2)

Twoje tętno jest na normalnym poziomie. Kontynuuj trening; wykonuj intensywne i lekkie ćwiczenia, nie
zapominając o dniach odpoczynku.

Training Effect (3)

Twoje tętno jest niższe niż zwykle. Najprawdopodobniej w ostatnich dniach intensywnie ćwiczyłeś . Masz
dwie opcje: 1) odpocznij, ewentualnie trenuj lekko przez jeden lub dwa dni, albo 2) kontynuuj intensywne
treningi przez jeden lub dwa dni, a następnie dobrze odpocznij. Podobne symptomy mogą występować w
przypadku stresu lub w początkowych stanach przeziębienia/grypy.

Steady State (4)

Twoje tętno od pewnego czasu jest na normalnym poziomie. Efektywny trening wymaga ciężkich
treningów oraz dobrej regeneracji, co z kolei powinno powodować zmiany tętna. Twój OwnOptimizer
wskazuje, że nie ćwiczyłeś dostatecznie ciężko lub niedostatecznie się zregenerowałeś. Powtórz test po
dniu odpoczynku, ewentualnie lekkiego treningu. Jeżeli odpoczynek okaże się wystarczający, wynik testu
powinien wskazać Good recovery.

Stagnant State (5)

Twoje tętno nadal jest na normalnym poziomie, co trwa już od dłuższego czasu. OwnOptimizer wskazuje,
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że nie ćwiczyłeś na tyle intensywnie, aby optymalnie się rozwijać. W celu poprawienia kondycji
powinieneś włączyć do swojego programu treningowego bardziej intensywne lub dłuższe ćwiczenia.

Hard Training (6)

Twoje tętno, kolejny raz z rzędu, jest wyższe niż zazwyczaj . Być może specjalnie zwiększyłeś
obciążenie treningowe. Wynik wskazuje na przeciążenie, w konsekwencji czego twój organizm wymaga
dobrej regeneracji W celu monitorowania regeneracji; powtórz test po jednym lub dwóch dniach
odpoczynku lub lekkich ćwiczeń.

Overreaching (7)

OwnOptimizer wskazuje, że ćwiczyłeś bardzo intensywnie przez kilka dni lub tygodni. Twoje tętno od
dłuższego czasu pozostaje na wysokim poziomie. Powinieneś, koniecznie, całkowicie się zregenerować.
Im dłuższy był okres intensywnych ćwiczeń, tym dłuższy powinien być okres regeneracji. Po upływie co
najmniej dwóch dni odpoczynku, wykonaj test ponownie .

Sympathetic Overtraining (8)

OwnOptimizer wskazuje, że ćwiczyłeś bardzo intensywnie przez kilka dni lub tygodni a regeneracja
okazała się niewystarczająca. Skutkiem czego organizm jest przetrenowany. W celu ustabilizowania
formy, odpocznij, dokładnie monitorując swój stan. Podczas odpoczynku wykonuj test 2-3 razy w
tygodniu.

Parasympathetic Overtraining (9)

Twoje tętno pozostaje na niskim poziomie; można to interpretować jako stan dobrej regeneracji. Jednak
pozostałe parametry wskazują na przetrenowanie Najprawdopodobniej przez długi okres ciężko
trenowałeś a odpoczynki nie były wystarczające. Sprawdź, czy występują pozostałe objawy
przetrenowania, takie jak ciągłe zmęczenie, zły humor, problemy ze spaniem, przewlekłe bóle mięśni
i/lub uczucie wypalenia. Być może stan ten wynika również z innego typu obciążeń.

Generalizując, zazwyczaj przetrenowanie wywołane jest długim okresem ciężkich ćwiczeń.
Rozwiązaniem tego typu sytuacji jest całkowita regeneracja organizmu. Regeneracja taka może potrwać
kilka tygodni. Nie powinieneś ćwiczyć; wprost przeciwnie, większość okresu regeneracji przeznacz na
odpoczynek. Możesz w tym czasie przeprowadzić kilka bardzo lekkich treningów aerobowych, a tylko
wyjątkowo trening intensywny (krótki).

Możesz również rozważyć uprawianie innego, niż twój główny, sportu. Nie może jednak się z tym wiązać
nadmierny wysiłek czy przeciążenie. Podczas odpoczynku wykonuj test 2-3 razy w tygodniu. Gdy
poczujesz, że odzyskałeś już równowagę i twój wynik pokazuje Normal State lub Good recovery
(najlepiej wiecej niż raz), możesz rozważyć powrót do treningu. Jeżeli zdecydujesz się na nowo
rozpocząć cykl treningowy, wyznacz ponownie wartość wyjściową.

Wskazane jest, aby przed radykalną zmianą programu treningowego dokonać analizy wyników testu
OwnOptimizer, nie pomijając przy tym takich aspektów jak samopoczucie czy innych, istotnych z punktu
widzenia treningu, objawów . Jeżeli nie jesteś pewien czy warunki, w jakich przeprowadzony był test, były
optymalne, powtórz go. Na wynik testu mogą mieć wpływ niektóre czynniki zewnętrzne: stres psychiczny,
niedawno przebyta choroba, zmiana otoczenia (temperatura, wysokość) oraz inne. Co najmniej raz w
roku, na początku sezonu, należy na nowo wyznaczyć wartość wyjściową.

OwnOptimizer Trend
Wybierz Test > Optimizer > Trend

Zobacz jak twoja wartość OwnOptimizer została opracowana w menu Trend. Zawiera ono 16 ostatnich
wartości OwnOptimizer wraz z datami ich zapisu. Jeżeli plik się zapełni, najstarszy zapis automatycznie
zostaje zastąpiony przez najnowszy wynik.

Wyświetlony zostanie najnowszy pomiar, wraz z datą, oraz wykres trendu OwnOptimizer. Wciśnij OK by
zobaczyć opis wyniku. Przewiń za pomocą UP lub DOWN by przeglądać pozostałe wartości.
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Usuń wartości OwnOptimizer.
Wybierz Test > Optimizer > Trend

Wybierz wartość i przytrzymaj LIGHT. Delete value? No/Yes zostanie wyświetlone. Potwierdź za pomocą
OK.

Resetowanie pliku Trend
Wybierz Test > Optimizer > Reset

Możesz wyzerować OwnOptimizer Wszystkie wyniki zostaną usunięte z pamięci. Podczas wykonywania
testu po 365 dniach, lub pierwszy raz po 30 dniach, Reset test period? zostanie wyświetlone.

Analiza wyników za pomocą programu Polar ProTrainer 5.
Przesłanie rezultatu do ProTrainera 5 umożliwia Ci analizę wyników na różne sposoby, tak jak dostęp do
bardziej szczegółowych informacji o Twoich postępach. Oprogramowanie umożliwia również stworzenie
wykresu porównującego wcześniejsze wyniki. Wyniki OwnOptimizer są przesyłane do oprogramowania
automatycznie wraz z ćwiczeniami gdy używasz połączenia z monitorem.
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10. UZYWANIE NOWEGO NADAJNIKA

Używanie nowego nadajnika
Twój licznik CS600X musi zostać "nauczony" aby działać wraz z nadajnikiem Polar WearLink W.I.N.D.
Innymi słowy, twój licznik otrzyma sygnały tylko z twojego nadajnika, co umożliwia prowadzenie treningu
w grupach, bez żadnych zakłóceń.

Jeśli zakupiłeś nowy nadajnik jako dodatkowy sensor, to musi być on "nauczony" w liczniku Nazywamy to
"uczeniem"; trwa ono zaledwie kilka sekund.

Aby zapobiec zakłóceniom podczas zawodów, upewnij się, że "nauczyłeś" sensorów przed rozpoczęciem
tego wydarzenia.

"Uczenie" nowego sensora.
Załóż nadajnik i upewnij się, że w zasięgu 40 metrów nie ma innego nadajnika Polar WearLink W.I.N.D.
Na ekranie głównym wciśnij OK. Licznik rozpocznie szukanie sygnału nadajnika.

Gdy dokona jego identyfikacji, New WearLink found, Teach new WearLink? zostanie wyświetlone.

• Wybierz Yes aby potwierdzić nauczenie.. Completed! zostanie wyświetlone, gdy proces "uczenia" się
zakończy. Rozpocznij zapis ćwiczenia naciskając OK.

• Wybierz No aby anulować ćwiczenie.
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11. UZYWANIE NOWYCH AKCESORIÓW

Używanie nowych akcesoriów.
Nowy sensor zakupiony osobno poza zestawem musi zostać "nauczony" przez licznik. Nazywamy to
"uczeniem"; trwa ono zaledwie kilka sekund. Innymi słowy, twój licznik otrzyma sygnały tylko z twojego
nadajnika co umożliwia prowadzenie treningu w grupach, bez żadnych zakłóceń. Jeśli zakupiłeś sensor i
licznik jako zestaw, to sensor powinien być od razu "nauczony" aby działać razem z odbiornikiem. Musisz
jedynie aktywować sensor w liczniku

Możesz "nauczyć" jeden sensor prędkości, kadencji i mocy dla każdego z rowerów.

"Uczenie" nowego sensora prędkości.
Wybierz Settings > Bike > Bike1/2/3 > Speed > On/Off.Teach new sensor? zostanie wyświetlone.

• By "nauczyć" nowy sensor, upewnij się, że w zasięgu 40 metrów nie ma innego sensora prędkości.
Wówczas wybierz Yes aby potwierdzić "nauczenie". Start test drive zostanie wyświetlone. Obróć koło
kilka razy aby aktywować sensor. Migająca czerwona dioda wskazuje, że sensor jest aktywny.
Completed! zostanie wyświetlone, gdy proces "uczenia" się zakończy. Licznik jest już gotowy do
odbierania danych o prędkości i dystansie.

• Wybierz No aby anulować "uczenie", wówczas używany będzie sensor "uczony" poprzednio.

Gdy sensor prędkości zostanie już "nauczony", to będzie pamiętać do jakiego odbiornika został
przystosowany, nawet po wyłączeniu. Gdy sensor prędkości zostanie ponownie włączony, Teach new

sensor? zostanie wyświetlone. Wybierz NO. Jeśli wybrałeś YES, licznik rozpocznie "uczenie" nowego
sensora.

"Uczenie" nowego sensora kadencji*
Wybierz Settings > Bike > Bike1/2/3 > Cadence > On/Off. Teach new sensor? zostanie wyświetlone.

• By "nauczyć" nowy sensor, upawnij się, że w zasięgu 40 metrów nie ma innego sensora kadencji.
Wówczas wybierz Yes by potwierdzić "nauczenie". Start test drive zostanie wyświetlone. Obróć koło
kilka razy aby aktywować sensor. Migająca czerwona dioda wskazuje, że sensor jest aktywny.
Completed! zostanie wyświetlone gdy proces "uczenia" się zakończy. Licznik jest teraz gotowy do
odbierania sygnałów z sensora kadencji.

• Wybierz No aby anulować "uczenie". Licznik nie będzie zdolny do pomiaru kadensji.

Gdy sensor kadencji zostanie już "nauczony", to będzie pamiętać do jakiego odbiornika został przystosowany,
nawet po wyłączeniu. Gdy sensor kadencji zostanie ponownie włączony, Teach new sensor? zostanie
wyświetlone. Wybierz NO i licznik wejdzie w tryb On/Off. Wybierz ON aby aktywować sensor kadencji. Jeśli
wybrałeś YES, licznik rozpocznie "uczenie" nowego sensora.

"Uczenie" nowego sensora pomiaru mocy*
Wybierz Bike > Bike1/2/3 > Power > On/Off . Teach new sensor? zostanie wyświetlone.

• By "nauczyć" nowy sensor, upewnij się, że w zasięgu 40 metrów nie ma innego sensora mocy. Wówczas
wybierz Yes by potwierdzić "nauczenie". Start test drive zostanie wyświetlone. Obróć koło kilka razy aby
aktywować sensor. Migająca czerwona dioda wskazuje, że sensor jest aktywny. Completed! zostanie
wyświetlone gdy proces "uczenia" się zakończy. Licznik jest teraz gotowy do odbierania sygnałów z
sensora mocy.

• Wybierz No aby anulować "uczenie". Licznik nie będzie zdolny do pomiaru mocy.

Gdy sensor pomiaru mocy zostanie już "nauczony", to będzie pamiętać do jakiego odbiornika został
przystosowany, nawet po wyłączeniu. Gdy sensor mocy zostanie ponownie włączony, Teach new sensor?
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zostanie wyświetlone. Wybierz NO. Licznik przejdzie w tryb On/Off. Ostanio "nauczony" sensor mocy zosnie
użyty. Jeśli wybrałeś Yes, licznik rozpocznie "uczenie" nowego sensora.

"Uczenie" nowego sensora GPS G3*
Włącz sensor GPS G3 i wybierz Settings > Features > GPS > On w liczniku.. Teach new sensor? zostanie
wyświetlone.

• Wybierz Yes aby potwierdzić "nauczenie". Completed! Zostanie wyświetlone.

• Wybierz No aby anulować "uczenie". Licznik nie będzie zdolny do pomiaru danych GPS.

*wymagany jest opcjonalny sensor

POLSKI

Uzywanie nowych akcesoriów 55



12. INFORMACJE PODSTAWOWE

Polar Sport Zones
Strefy Polara oferują nowy poziom efektywności podczas treningów bazujących na tętnie. Trening jest
rozdzielany na pięć stref bazujących na procencie twojego tętna maksymalnego. Ze strefami, możesz
łatwo wybrać i monitorować intensywność treningów, oraz ćwiczyć zgodnie z programami bazującymi na
strefach.

Strefa docelowa Intensywność
w % HRmax,
bpm

Przykładowy
czas trwania

Korzyść treningowa

MAXIMUM

90–100%
171–190 bpm

Poniżej 5
minut

Korzy#ci: Maksymalny lub prawie
maksymalny wysiłek dla oddechu i mięśni.

Odczucie: Duże wyczerpanie mięśni i
oddechu.

Zalecane dla: Bardzo doświadczonych i
wytrenowanych kolarzy. Tylko krótkie

interwały, zazwyczaj ostateczne
przygotowanie do zawodów na krótkim

dystansie.

HARD

80–90%
152–172 bpm 2–20 minut

Korzy#ci: Poprawienie zdolności
utrzymywania wększego wysiłku.

Odczucie: Powoduje zmęczenie mięśni i
ciężki oddech.

Zalecane dla: Doświadczonych kolarzy do
całorocznych treningów . Istotne przy

przygotowaniu do sezonu.

MODERATE

70–80%
133–152 bpm 10–60 minut

Korzy#ci: Poprawia szybkość treningu,
sprawia że umiarkowana intensywność jest

łatwiejsza i poprawia wydolność.
Odczucia: Jazda dobrym tempem ze średnią

kadencją.
Zalecane dla: Kolarzy biorących udział w

zawodach lub szukających korzyści
wydolnościowej .

LIGHT

60–70%
114-133 bpm 60–300 minut

Ko#y#ci: Poprawa kondycji, poprawa
regeneracji i metabolizm.

Odczucia: Lekkie obciążenie dla mięśni i
układu krążenia.

Zalecane dla: Każdego do długich sesji
treningowych podczas podstawowego
treningu i dla ćwiczeń regeneracyjnych

podczas sezonu zawodów.

VERY LIGHT

50–60%
104–114 bpm 20–60 minut

Korzy#ci: Pomaga się rozgrzać i uspokoić
oraz wspomaga regeneracje.

Odczucia: Lekki wysiłek.
Zalecane dla: Dla regeneracji i ćwiczeń
wyciszających podczas sesji treningowej.

HRmax = Tętno maksymalne (220-wiek). Przykład: 30 lat, 220–30=190 bpm.

Jazda w sport zone 1 (Very light) jest wykonywana w bardzo niskiej intensywności. Podstawą treningu
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jest poprawa poziomu wydajności po treningu; podczas okresu regeneracji (nie tylko podczas ćwiczenia).
Możesz przyspieszyć proces regeneracji ćwicząc z bardzo niską intensywnością.

Sport zone 2 (Light) jest od treningów wytrzymałościowych; nieodłączna część każdego programu
treningowego. Sesja jazdy w tej strefie jest łatwa. Długie treningi w tej strefie charakteryzuje efektywny
wydatek energetyczny. Postęp będzie wymagał wytrwałości.

Wydolność tlenowa jest wzmacniana w sport zone 3 (Moderate) . Intensywność treningu jest większa niż
w sport zones 1 i 2, lecz nadal ma na celu poprawę wydolności tlenowej. Przykładowo: ćwiczenie w sport
zone 3 może składać się z, poprzedzonych regeneracją, interwałów. Jazda w tej strefie jest szczególnie
efektywna przy poprawie krążenia i wzmacnianiu mięśni.

Jeżeli twoim celem jest współzawodnictwo na najwyższym poziomie, będziesz musiał trenować w sport

zones 4 i 5. W tych strefach, powinieneś jeździć beztlenowo w interwałach trwających maksymalnie 10
minut. Im krótszy interwał, tym większa intensywność. Bardzo ważny jest tutaj odpowiedni czas odnowy
pomiędzy interwałami. Szablon treningu w strefach 4 i 5 jest zaprojektowany w taki sposób, aby osiągnąć
maksymalne wyniki.

Jeśli jeździsz w wyznaczonych strefach to środek danej strefy jest najlepszym celem, ale nie utrzymuj
tętna w miejscu cały czas. Intensywność treningu, poziom regeneracji, samopoczucie i inne czynniki
będą oddziaływać na pracę serca. Ważne jest, aby zwracać uwagę na uczucie zmęczenia i dopasować
do niego program treningowy.

Prostym sposobem korzystania ze stref, jest utworzenie pożądanych stref tętna. Aby uzyskać więcej
informacji, przejdź doPlanowanie treningu (strona 11).

Po zakończeniu sesji, zostanie wyświetlony czas spędzony w strefie. Wejdź do opcji Weekly aby
wyswietlić strefy, w jakich ćwiczyłeś i jaki czas w nich spędziłeś. Oprogramowanie Polar ProTrainer 5
oferuje do 10 stref aby lepiej wspomóc twoje potrzeby treningowe i rezerwę tętna.

Trening OwnZone
Twój licznik automatycznie wyznaczy indywidualną i bezpieczną intensywność ćwiczenia: Twoje
OwnZone. Polar OwnZone to wyznaczona specjalnie dla ciebie strefa treningu tlenowego. Funkcja ta
przeprowadza cię przez rozgrzewkę, uwzględniając przy tym twój aktualny stan fizyczny i psychiczny. Dla
większości osób dorosłych, OwnZone odpowiada 65-85% tętna maksymalnego.

OwnZone może być wyznaczone w 1-5 minut podczas rozgrzewki poprzez jazdę na rowerze, chodzenie,
bieganie lub uprawianie innej aktywności. Test polega na powolnym rozpoczęciu ćwiczenia, z małą
intensywnością, a następnie stopniowym zwiększaniu tempa. OwnZone jest przeznaczone dla zdrowych
osób. Niektóre czynniki, związane ze stanem zdrowia, mogą uniemożliwić wyznaczenie OwnZone.
Należą do nich wysokie ciśnienie krwi, arytmia serca jak również przyjmowanie niektórych leków.

Istotna, celem utrzymania dobrej kondycji, jest umiejętność oceny i interpretacji zachowań własnego ciała
podczas wysiłku fizycznego.. Ponieważ rozgrzewka dla różnych typów ćwiczeń nie jest taka sama, a
także psychiczny i fyzyczny stan może się różnić każdego dnia (np. z powodu stresu lub choroby), to
używanie OwnZone dla każdej sesji gwarantuje najefektywniejsze wyznaczenie strefy tętna dla danego
ćwiczenia i dnia.

W celu uzyskania dalszych informacji o wyznaczaniu OwnZone, przejdź doWyznaczenie OwnZone
(strona 22).

Tętno maksymalne
Tętno maksymalne (HRmax) to maksymalna ilość skurczów serca na minutę (bpm) podczas
maksymalnego wysiłku fizycznego. Wielkość ta jest indywidualną i zależną od twojego wieku,
predyspozycji genetycznych oraz poziomu sprawności fizycznej. Może się ono również zmieniać w
zależności od rodzaju uprawianego sportu. HRmax jest używane do określenia poziomu intensywności
ćwiczenia.

Wyznaczanie maksymalnego tętna
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Twoje HRmax może zostać wyznaczone na kilka sposobów.

Najdokładniejszą metodą wyznaczenia HRmax jest pomiar kliniczny. Test wysiłkowy, przeprowadzany
przez kardiologa lub fizjologa, jest zazwyczaj wykonywany na bieżni lub rowerze.

Możesz również samodzielnie wyznaczyć swoje HRmax ; podczas ćwiczenia razem z partnerem.

Ocena wyniku HRmax-p które przewiduje twoje HRmax może być wykonana poprzez przeprowadzenie
Polar Fitness Testu.

Zazwyczaj używana jest formuła: 220 - wiek, jednak badania wskazują, że metoda ta nie jest zbyt
dokładna (szczególnie w przypadku osób starszych lub osób, które trenują od wielu lat).

Jeżeli kilka tygodni temu zakończyłeś ciężki trening i wiesz, że potrafisz bezpiecznie osiągnąć tętno
maksymalne, możesz bez przeszkód, samodzielnie wykonać test wyznaczania HRmax. Zalecane jest, aby
podczas przeprowadzania testu ktoś z tobą był. Jeżeli masz wątpliwości, przed wykonaniem testu
skonsultuj się z lekarzem .

Oto przykład prostego testu.

Krok 1: 20 minutowa rozgrzewka na płaskiej nawierzchni, przejście do zwyczajowego tempa treningu.

Krok 2: Wybierz wzniesienie, na pokonanie którego potrzebujesz więcej niż 2 minuty. Wyjedź na to
wzniesienie tempem, które możesz utrzymać maksymalnie przez 20 minut. Zjedź z powrotem na sam dół
wzniesienia.

Krok 3: Wjedź na nie jeszcze raz tempem, które możesz utrzymać maksymalnie przez 10 minut. Zanotuj
swoje maksymalne tętno. Twoje maksimum jest około 10 uderzeń wyższe niż wartość, którą zapisałeś.

Krok 4: Zjedź z powrotem na dół, pozwól aby twoje tętno spadło o 30-40 bpm.

Krok 5: Wyjedź jeszcze raz na wzniesienie z tempem, które możesz utrzymać przez 1 minutę. Spróbuj
przejechać połowę wzniesienia. Zanotuj swoje maksymalne tętno. Zbliżyłeś się do maksymalnego tętna.
Użyj tej wartości jako tętno maksymalne w training zones.

Krok 6: Upewnij się, że dobrze odpocząłeś, minimum 15 minut.

Tętno spoczynkowe
HRsit jest to średnie tętno podczas całkowitego braku ruchu (np. podczas siedzenia). Aby wyznaczyć
HRsit ; załóż nadajnik, usiądź i postaraj się nie ruszać. Celem uzyskania bardziej precyzyjego pomiaru,
powtórz procedurę kilka razy i oblicz średnią.

Rezerwa tętna
Rezerwa tętna (HRR) jest to różnica pomiędzy tętnem maksymalnym (HRmax) a tętnem spoczynkowym
(HRrest)*. HRR jest używane do wyliczania tętna ćwiczenia. Jest to zakres w obrębie tętna; zmienia się
on w zależności od poziomu wysiłku. HRR dorównuje absorbcji rezerw tlenu (VO2R).

Tętno odpowiednie do przeprowadzania ćwiczeń można obliczyć za pomocą wzoru Karvonena**. Do
wyrażonej w procentach rezerwy tętna dodaj tętno spoczynkowe.

HR ćwiczenia = % zamierzonej intensywności (HRmax – HRrest) + HRrest

Przykład:

Założenie; intensywność 70 % HRR dla osoby z HRmax 201 bpm i HRrest 50 bpm

HR ćwiczenia = 70% (201-50) + 50

HR ćwiczenia = 156 bpm

POLSKI

58 Informacje podstawowe



Celem dokładnego określenia HR ćwiczenia, potrzebujesz dokładnych wartości HRmax oraz HRrest. Jeżeli
używasz szacunkowego HRmax, wartość tętna ćwiczenia zawsze będzie szacunkowa.

*W Polarze CS600X, wartość tętna podczas spoczynku jest mierzona w pozycji siedzącej (HRsit). Jest to
konieczne, z uwagi na dokładność pomiaru (HRsit jest wykorzystywane do obliczenia wydatku
energetycznego). HRsit dopasowuje niską intensywność do ćwiczeń, których intensywność może być
porównana.

**Karvonen M, Kentala K, Mustala O. Efekt treningu pracy serca: długotrwałe badania. Ann Med Exp Biol
Fenn 1957; 35: 307-315.

Zmienność tętna
Każdy skurcz serca jest inny. Zmienność tętna (HRV) jest zmienną interwałów każdego skurczu serca,
znane również jako interwał R-R.

HRV wskazuje na odchylenia tętna od tętna średniego. Tętno średnie w wartości 60 skurczów na minutę
(bpm) nie oznacza, że odstępy pomiędzy skurczami wynoszą dokładnie 1.0 sek. ponieważ mogą one
trwać od 0.5 sek do 2.0 sek.

Wydolność tlenowa ma wpływ na HRV HRV dla serca w dobrej kondycji jest zazwyczaj niskie w
spoczynku. Inne czynniki, które mają wpływ na HRV to wiek, uwarunkowania genetyczne, pozycja ciała,
pora dnia oraz stan zdrowia. Podczas ćwiczenia, HRV zmniejsza się wraz ze wzrostem intensywności.
HRV zmniejsza się także w stanie stresu.

HRV jest regulowane przez autonomiczny system nerwowy. Aktywność parasympatyczna obniża tętno i
zwiększa HRV, podczas gdy aktywność sympatyczna zwiększa tętno i zmniejsza HRV.

HRV jest używane w opcjach Ownzone, OwnIndex i OwnOptimizer. Może być równieżmonitorowane
samo za pomocą licznika. Jeśli Twoje HRV zmienia się w podawanym tempie i tętnie, to może to
wskazywać na to zmiany w obciążeniu treningu lub zmęczenie.

Zapis R-R
Zapis R-R pozwala na zapisanie odległości pomiędzy dwoma skurczami serca. Informacja ta jest
wyświetlana również jako tętno wyrażone w skurczach serca na minutę.

Przy takim zapisie możliwe jest zauważenie każdego, dodatkowego skurczu serca. Celem optymalnego
kontaktu nadajnika ze skórą zaleca się użycie specjalnego żelu (żel ECG). Odczyty zinterpretowane jako
niewłaściwe w danych tętna mogą zostać poprawione za pomocą oprogramowania Polar ProTrainer 5.
W celu uzyskania dalszych informacji o poprawie wydolności w kolarstwie przejdź do. Polar Article
Library [http://articles.polar.fi/en/1_segment.html].
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13. INFORMACJE SERWISOWE DLA KLIENTA

Konserwacja i przechowywanie
Jak każde urządzenie elektroniczne, Polar powinien być przechowywany w optymalnych dla niego
warunkach. Stosowanie się do poniższych wskazówek umożliwi nie tylko zachowanie gwarancji ale i
bezawaryjne działanie Polara przez wiele lat.

Konserwacja
Po każdym użyciu odpinaj nadajnik od elektrod. Przemyj nadajnik delikatnym roztworem wody z
mydłem. Wysusz go za pomocą papierowego ręcznika. Nigdy nie używaj alkoholu lub innych materiałów
mogących uszkodzić urządzenie (gąbki drucianej lub mocnych środków chemicznych).

Myj elektrody po każdym użyciu. Jeśli używasz elektrod więcej niż trzy razy w tygodniu, pierz je w
pralce przynajmniej raz na trzy tygodnie, w temperaturze 40°C / 104°F. Pierz elektrody, wkładając je do
płóciennego worka lub poszewki. Nie namaczaj ich i nie stosuj detergentów z wybielaczem lub
zmiękczaczem. Nie wybielaj elektrod.

Pierz elektrody zawsze przed dłuższą przerwą w treningu oraz po ćwiczeniach w basenie z chlorowaną
wodą. Nie wkładaj ich do suszarki i nie prasuj. Nigdy nie wkładaj nadajnika do pralki lub suszarki!
Nadajnik i elektrody susz i przechowuj osobno.

Przechowuj licznik, nadajnik i sensory w ciepłym i suchym miejscu. Nie trzymaj ich w wilgotnym miejscu,
w nie-oddychających materiałach (plastikowa lub sportowa torba) lub w mokrych materiałach (mokry
ręcznik). Licznik, nadajnik i sensory są wodoszczelne i mogą być używane podczas deszczu. Aby
zachować szczelność, nie myj licznika lub sensorów wodą pod dużym ciśnieniem jak również nie
zanurzaj ich pod wodą. Nie narażaj Polara na bezpośrednie działanie promieni słonecznych.

Utrzymuj licznik w czystości. Wyczyść licznik i sensory delikatnym roztworem wody z mydłem i przepłucz
pod bieżącą wodą. Nie zanurzaj ich w wodzie. Wysusz je delikatnie za pomocą papierowego ręcznika.
Nigdy nie używaj alkoholu lub innych materiałów mogących uszkodzić urządzenie (gąbki drucianej lub
mocnych środków chemicznych).

Aby nie uszkodzić licznika i / lub sensorów, unikaj uderzania nimi.

* Opcjonalne sensory.

Serwis
Jeżeli, podczas obowiązywania dwuletniej grawancji, twój licznik Polara będzie potrzebować napraw ,
zalecamy aby dostarczyć go wyłącznie do autoryzowanego serwisu firmy Polar. Gwarancja nie obejmuje
zniszczeń powstałych w trakcie, lub w wyniku wykonywania napraw przez osoby do tego
nieupoważnione. Celem uzyskania dalszych informacji, przejdź do Ograniczona gwarancja firmy Polar
(strona 65).

W celu uzyskania informacji o lokalnych placówkach serwisowych, skontaktuj się z dystrybutorem w
danym kraju.

Wymiana baterii
Dokonuj wymiany baterii w autoryzowanym Centrum Serwisowym Polara Unikaj otwierania pokrywy
baterii. Jeśli jednak zdecydowałeś się aby wymienić baterię samodzielnie, postępuj zgodnie z
instrukcjami zawartymi na następnej stronie.

Aby wymienić baterię w liczniku i nadajniku samodzielnie, postępuj zgodnie z instrukcją w Wymiana
Baterii Licznika. Instrukcja zawiera informacje dla wszystkich baterii.

Jeżeli chciałbyś aby wymiany dokonał Polar, skontaktuj się z autoryzowanym centrum serwisowym.

Wymiana Baterii Licznika
Aby wymienić baterię w liczniku, potrzebujesz monety i odpowiedniej baterii (CR 2354).
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1. Używając monety, otwórz kapsel baterii,
przekręcając go w kierunku odwrotnym do
wskazówek zegara

2. Zdejmij kapsel baterii. Bateria jest
przymocowana do kapsla; ostrożnie ją unieś.
Usuń baterię/zastąp ją nową. Bądź ostrożny; nie
uszkodź kapsla lub tyłu obudowy .

3. Umieść baterię plusem (+) w stronę
kapsla/minusem (-) w stronę odbiornika.

4. Do przykrywki przymocowana jest również
uszczelka kapsla . Zmień uszczelkę, jeżeli jest
uszkodzona. Przed zamknięciem kapsla,
upewnij się, że uszczelka nie jest uszkodzona i
że poprawnie umieściłeś ją w rowku .

5. Włóż kapsel na swoje miejsce; zamknij za
pomocą monety, przekręcając go zgodnie z
ruchem wskazówek zegara, do pozycji CLOSE.
Upewnij się, że kapsel został właściwie
założony!

Nadmierne używanie podświetlenia, powoduje szybsze rozładowanie się baterii. Wskaźnik zużycia baterii
może pojawić się także przy używaniu Polara w niskich temperaturach; zniknie, gdy temperatura
otoczenia wzrośnie. Pokrywę baterii otwieraj jedynie w celu wymiany baterii. W trakcie wymiany baterii
sprawdź czy nie jest zniszczona uszczelka. Jeśli tak, należy ją wymienić. Baterie i uszczelki możesz
kupić w dobrze zaopatrzonych sklepach Polara jak również w autoryzowanym serwisie. W USA i
Kanadzie uszczelki są dostępne wyłącznie w autoryzowanych Centrach Serwisowych Polara.

Trzymaj baterie z daleka od dzieci. W przypadku połknięcia baterii przez dziecko, niezwłocznie skontaktuj się z
lekarzem. Zgodnie z obowiązującym prawem, zużyte baterie wyrzucaj do odpowiednich pojemników.

Baterie sensorów prędkości i kadencji.

Skontaktuj się z autoryzowanym serwisem w celu wymiany sensorów prędkości i kadencji.

Bateria sensora pomiaru mocy.

Przejdź do osobnej instrukcji dla Power Output W.I.N.D. Sensor aby zapoznać się z instrukcją wymiany
baterii.

Uwagi

Zakłócenia podczas ćwiczeń
Zakłócenia elektromagnetyczne i sprzęt sportowy

Zakłócenia mogą występować w pobliżu źródeł wysokiego napięcia lub w otoczeniu komputerów.
Również stacje WLAN mogą powodować zakłócenia podczas treningu z CS600X. Aby wyeliminować
przerwy w odczytach lub nieprawidłowe wskazania, unikaj zbliżania się do potencjalnych źródeł zakłóceń.

Zakłócenia mogą powodować również niektóre części elektronicznego sprzętu sportowego np.
wyświetlacze LED, silniki czy hamulce elektromagnetyczne. W celu rozwiązania tego problemu, postępuj
wg poniższego:

1. Zdejmij nadajnik z klatki piersiowej i rozpocznij ćwiczenie na powodującym zakłócenia sprzęcie.
2. Obracaj licznik póki nie znajdziesz obszaru, w którym nie ma wyświetlonego tętna lub symbol serca nie

mruga. Zakłócenia są mocniejsze naprzeciwko wyświetlacza, podczas gdy lewa i prawa strona jest
zazwyczaj wolna od zakłóceń.
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3. Załóż nadajnik z powrotem na klatkę piersiową i utrzymuj licznik w strefie wolnej od zakłóceń.

Jeśli licznik nadal nie działa z nadajnikami, to prawdodpodobnie jest zbyt dużo zakłóceń elektrycznych w
powietrzu by prowadzić bezprzewodowy pomiar tętna.

Minimalizacja ryzyka podczas ćwiczenia
W przypadku niektórych osób, z uwagi na ich stan zdrowia, trening może być obciążony pewnym
stopniem ryzyka Zanim zaczniesz regularne ćwiczenia odpowiedz na poniższe, dotyczące twojego stanu
zdrowia, pytania. Jeżeli odpowiesz TAK na jakiekolwiek z tych pytań, przed rozpoczęciem ćwiczeń
skonsultuj się z lekarzem.
• Czy w ciągu ostatnich 5 lat nie byłeś aktywny fizycznie?
• Czy masz wysokie ciśnienie krwi lub wysoki poziom cholesterolu?
• Czy masz objawy jakiejkolwiek choroby?
• Czy zażywasz jakiekolwiek leki na ciśnienie krwi lub na serce?
• Czy masz lub miałeś problemy z oddychaniem?
• Czy jesteś w trakcie rehabilitacji po przebytej chorobie lub po operacji?
• Czy używasz rozrusznika serca lub innego, wszczepionego urządzenia elektronicznego?
• Czy palisz papierosy?
• Czy jesteś w ciąży?

Wysiłek fizyczny nie jest jedynym czynnikiem wpływającym na tętno. Wybierając stopień intensywności
treningu, weź pod uwagę że: leki, ciśnienie krwi, kondycja psychiczna, astma, wydolność oddechowa etc.
jak również napoje energetyzujące, alkohol oraz nikotyna mają wpływ na pracę serca.

Istotnym jest zwracanie uwagi na reakcje organizmu podczas treningu. Jeżeli poczujesz
niespodziewany ból lub też czujesz duże zmęczenie podczas ćwiczenia, zaprzestań treningu lub
zmniejsz jego intensywność

Informacje dla osób z rozrusznikami serca, defibrylatorami lub innymi wszczepionymi
urządzeniami elektronicznymi. Osoby posiadające stymulator serca używają licznika Polara na własne
ryzyko. Przed rozpoczęciem użytkowania, zaleca się wykonanie ćwiczenia (z maksymalnym
obciążeniem) pod nadzorem lekarza. Test przeprowadza się aby zapewnić bezpieczne używanie Polara
ze stymulatorem.

Jeżeli jesteś uczulony na materiały, które mają kontakt ze skórą i obawiasz się reakcji
uczuleniowej podczas używania produktu, sprawdź w Specyfikacji Technicznej listę materiałów, z
jakich jest on wykonany. Aby uniknąć reakcji alergicznej na elektrody, zakładaj je na koszulkę. Aby
zapewnić optymalne działanie elektrod, zmocz dokładnie koszulkę w miejscu ich założenia.

Pod wpływem potu nadajnik może zafarbować jasne ubrania na czarno. Jeżeli stosujesz zewnętrznie preparaty
do odstraszania owadów upewnij się, że nie wejdą one w reakcję z nadajnikiem.

Specyfikacja techniczna

Licznik

Laser Product 1 klasy
Żywotność baterii: Średnio 1 rok (1h/dzień, 7 dni w tygodniu)
Typ baterii: CR 2354
Uszczelka baterii: O-ring 20,0 x 1,0 Materiał: silikon
Temperatura, w jakiej działa nadajnik: -10 °C do +50 °C / 14 °F do 122 °F
Materiały: Termoplastyczny polimer
Dokładność zegarka: Lepsza niż ± 0,5 sekundy / dzień przy temperaturze 25 °C.
Dokładność monitora pracy serca: ± 1% lub 1 bpm. Przy założeniu stabilnych warunków.
Zakres pomiaru tętna: 15-240
Zakres pomiaru prędkości: 0-127 km/h
Zakres pomiaru wysokości: -550 m … +9000 m
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Zakres wzniesień: 5 m

Wartości limitów licznika

Maksymalna ilość plików: 99
Maksymalny czas pliku: 99 h 59 min 59 s
Maksymalna ilość okrążeń: 99
Całkowity dystans: 999 999 km
Całkowity czas trwania: 9999h 59min 59s
Całkowita ilość kalorii: 999 999 kcal
Całkowita ilość ćwiczeń: 9999
Całkowita suma podejść: 304795 m

Nadajnik

Żywotność baterii w nadajniku WearLink
W.I.N.D. transmitter:

Średnio 2 lata (3h/dzień, 7 dni w tygodniu)

Typ baterii: CR2025
Uszczelka baterii: O-Ring 20.0 x 1.0, material silicone
Temperatura, w jakiej działa nadajnik: -10 °C do +40 °C
Materiał łącznika: Poliamid
Materiał paska: Poliuretan/ Poliamid/ Poliester/ Elastan/ Nylon

Polar ProTrainer 5™

Wymagania systemowe: PC
Windows® 2000/XP (32bit), Vista
Port na podczerwień IrDA (urządzenie zewnętrzne IrDA lub wbudowany
port IR)
Dodatkowo, poza oprogramowaniem, twój PC musi posiadać procesor
Pentium II 200 MHz (lub szybszy), monitor SVGA (lub lepszy), 50 MB
wolnej pamięci i stację dysków CD-ROM.

Polar WebLink używa komunikacji IrDA

Wymagania systemowe: PC
Windows® 98/98SE/ME/2000/XP
Port na podczerwień IrDA (urządzenie zewnętrzne IrDA lub wbudowany
port IR)

Licznik wyświetla wskaźniki twoich osiągów. Wyznacza poziom obciążenia fizycznego i intensywności
podczas ćwiczenia. Mierzy również prędkość i dystans podczas jazdy za pomocą sensora prędkości.
Sensor G3 GPS został zaprojektowany by mierzyć prędkość, dystans i lokalizację, jak również, aby
podawać informacje o przebytej trasie. Sensor kadencji został zaprojektowany, aby dostarczać informacji
o kadencji podczas jazdy. Sensor pomiaru mocy został zaprojektowany, aby wskazywać informacje o
mocy generowanej podczas jazdy. Użycie Polara w innych celach nie jest wskazane.

Licznik Polara nie powinien być używany w celu uzyskania pomiarów, które wymagają specjalistycznej
precyzji. Co więcej, urządzenie to nie powinno być używane do pomiaru w powietrzu lub pod wodą.

Wodoszczelność produktów Polara jest testowana zgodnie z międzynarodowym standardem ISO 2281.
Produkty są podzielone na trzy różne kategorie szczelności. Sprawdź kategorię szczelności produktu
Polara na jego odwrocie i porównaj ją z wykresem poniżej. Poniższe określenia nie muszą być zgodne z
definicjami podawanymi przez innych producentów.

Oznaczenie na odwrocie Charakterystyka wodoszczelności
Wodoszczelność Odporne na: ochlapanie, pot, krople deszczu. Nie używać

podczas pływania
Wodoszczelność 30 m/50 m Można stosować podczas pływania oraz kąpieli
Wodoszczelność 100 m Można stosować podczas pływania i nurkowania z ABC

(bez butli)

*Charakterystyka ta tyczy się również nadajnika Polar WearLink W.I.N.D. oznaczonego Water resistant.
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Najczęściej Zgłaszane Pytania
Co powinienem zrobić, gdy...

...symbol baterii i komunikat Battery low zostaną wyświetlone?

Pierwszym znakiem wyczerpania baterii jest zazwyczaj wskaźnik zużycia baterii. Wskaźnik ten może się
również pojawić w warunkach niskiej temperatury. Zniknie, gdy temperatura otoczenia wróci do normy.
Gdy symbol się pojawia, dźwięki i podświetlenie są automatycznie wyłączane. Aby uzyskać więcej
informacji na temat zmiany baterii, przejdź do Konserwacja i przechowywanie (strona 60).

...Nie wiem, w którym miejscu w menu się znajduję?

Wciśnij i przytrzymaj STOP do momentu aż powrócisz do ekranu głównego.

...przyciski nie reagują?

Zresetujk licznik naciskając wszystkie boczne przyciski i przytrzymując je przez 2 sekundy. Po resecie
wciśnij czerwony przycisk, Start with bike settings zostanie wyświetlone. Możesz zaakceptować
ustawienia roweru naciskając OK lub je zmienić. Basic Settings zostanie wyświetlone. Ustaw godzinę i
datę, wszystkie inne dane zostaną zachowane. Aby uzyskać więcej informacji, przejdź do Podstawowe
ustawienia (strona 7) oraz Pomiar rozmiaru koła. (strona 7). Jeśli nie chcesz zmieniać reszty ustawień, to
możesz je pominąć przytrzymując STOP. Wszystkie dane o treningach zostaną zachowane.

...licznik nie mierzy spalanych kalorii?

Spalone kalorie są wyliczane tylko wówczas, gdy masz założony nadajnik i dane podstawowe są
wprowadzone poprawnie. Aby uzyskać więcej informacji, przejdź do Podstawowe ustawienia (strona 7).

...inna osoba z licznikiem lub innych monitorem pracy serca powoduje zakłócenia?

ZobaczUwagi (strona 61).

...odczyt tętna staje się nieregularny, bardzo wysoki lub wskazuje zero (00)?
• Upewnij się, że licznik nie jest dalej niż 40 m od nadajnika..
• Sprawdź, czy nadajnik nie poluzował się podczas ćwiczenia.
• Sprawdź, czy elektrody w ubraniu sportowym są poprawnie ułożone.
• Sprawdź, czy elektrody są dostatecznie wilgotne.
• Sprawdź, czy nadajnik/ubranie sportowe są czyste.
• Upewnij się, że nie ma innego nadajnika w odległości 40 m.
• Przyczyną zakłóceń w pracy nadajnika może być silne pole elektromagnetyczne. Celem uzyskania

dalszych informacji, przejdź do Uwagi (strona 61).
• Jeżeli, pomimo oddalenia się od źródeł możliwych zakłóceń, złe wskazanie tętna nie ulegnie zmianie,

zwolnij i sprawdź tętno manualnie. Jeżeli twoje samopoczucie odpowiada wysokim wskazaniom w
odbiorniku, może mieć to związek z arytmią serca. Pomimo, iż większość przypadków arytmii nie jest
groźna, powinieneś skontaktować się z lekarzem

• Jakiś czynnik mógł zmienić siłę twoich fal ECG. W takim przypadku skonsultuj się z lekarzem.

…Check WearLink! zostanie wyświetlone i licznik nie może odnaleźć sygnału tętna?
• Upewnij się, że licznik nie jest dalej niż 40 m od nadajnika..
• Sprawdź, czy nadajnik nie poluzował się podczas ćwiczenia.
• Sprawdź, czy elektrody w ubraniu sportowym są poprawnie ułożone.
• Sprawdź, czy elektrody są dostatecznie wilgotne.
• Sprawdź, czy nadajnik/ubranie sportowe są czyste i nie są zniszczone.
• Jeżeli brak pomiaru występuje podczas ćwiczenia w stroju sportowym (z wszytymi przez producenta

elektrodami), spróbuj użyć elektrod z Wear Linka. Jeżeli przyniesie to efekt, problem najprawdopodobniej
dotyczy wspomnianego stroju sportowego. Skontaktuj się z jego sprzedawcą/producentem.

• Jeżeli wykonałeś wszystkie wspomniane wyżej czynności, a komunikat nadal się pojawia oraz nie ma
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sygnału pulsu, przypuszczalnie bateria w nadajniku jest wyczerpana. Celem uzyskania dalszych
informacji, przejdź do Konserwacja i przechowywanie (strona 60).

…New WearLink found. Teach new WearLink? zostanie wyświetlone.

Jeśli zakupiłeś nowy nadajnik osobno, to musi on zostać nauczony przez licznik. Celem uzyskania
dalszych informacji, przejdź do Uzywanie nowego nadajnika (strona 53).

Jeśli używasz nadajnika, który był dołączony do zestawu z licznikiem i wiadomość zostaje wyświetlona,
możliwe jest, że licznik odbiera sygnał od innego nadajnika. W takim przypadku upewnij się, że nadajnik,
który masz na sobie, jest twój oraz sprawdź, czy elektrody są dobrze zwilżone a nadajnik nie poluzował
się. Jeżeli komunikat nadal się pojawia, oznacza to, że bateria w nadajniku jest wyczerpana. Celem
uzyskania dalszych informacji, przejdź do Konserwacja i przechowywanie (strona 60).

...Check Speed! zostanie wyświetlone.

W celu uzyskania dalszych informacji, przejdź do instrukcji sensora Speed Sensor W.I.N.D.

…Check Power! jest wyświetlone?*

Sprawdź czy funkcja sensora mocy jest włączona w liczniku. Jeśli tak, to symbol rowerzysty powinien
zostać wyświetlony na liczniku Upewnij się, że sensor mocy jest założony poprawnie. Bateria sensora
może być wyczerpana. W celu dalszych informacji, przejdź do instrucji Power Output.

Teach new sensor? zostanie wyświetlone.

Jeśli zakupiłeś nowy WearLink W.I.N.D., Polar Cadence Sensor W.I.N.D.* lub Polar Power Sensor
W.I.N.D.* osobno, to muszą zostać nauczone przez licznik. Celem uzyskania dalszych informacji, przejdź
do Uzywanie nowych akcesoriów (strona 54).

...wysokość zmienia się, pomimo że się nie ruszam?

Licznik konwertuje ciśnienie powietrza na odczyt wysokości. Z tego powodu zmiana pogody może
spowodować zmianę wysokości.

…odczyty wysokości są niedokładne?

Wysokościomierz może wskazywać złą wysokość pod wpływem warunków zewnętrznych takich jak silny
wiatr lub klimatyzacja. W takim przypadku spróbuj skalibrować wysokościomierz. Jeżeli wskazania są
błędne przez cały czas, być może kanaliki pomiaru ciśnienia zostały zablokowane (przez kurz lub np.
błoto). W tym wypadku, wyśli licznik do autoryzowanego serwisu

...Memory low jest wyświetlone?

Memory low jest wyświetlane gdy pozostało mniej niż jedna godzina wolnej pamięci. Gdy pamięć się
zapełni to zostanie wyświetlony komunikat Memory full . Aby zwolnić pamięć, prześlij dane do
ProTrainera 5 i usuń je z pamięci licznika

*Opcjonalny sensor jest wymagany.

Ograniczona gwarancja firmy Polar
• Gwarancja międzynarodowa wydawana jest przez Polar Electro Inc. dla klientów, którzy kupili ten produkt

w USA lub Kanadzie. Gwarancja międzynarodowa wydawana jest przez Polar Electro Inc. dla klientów,
którzy kupili ten produkt w innych krajach.

• Polar Electro Oy/Polar Electro Inc. gwarantuje pierwszemu nabywcy tego urządzenia, że produkt będzie
wolny od wad materiałowych i produkcyjnych przez okres dwóch lat od daty zakupu. .

• Zatrzymaj kartę gwarancyjną oraz dowód zakupu, Serwis będzie ich wymagać podczas napraw
gwarancyjnych!

• Gwarancja nie obejmuje baterii, pęknięć/złamań obudów i pasków, zniszczeń spowodowanych
niewłaściwym użytkowaniem/nie przestrzeganiem uwag zawartych w instrukcji, wypadkami, używaniem
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produktu do celów komercyjnych.

• Gwarancja nie obejmuje także zniszczeń/strat, kosztów/wydatków, (bezpośrednich, pośrednich czy
przypadkowych), związanych z użytkowaniem produktu. W okresie gwarancyjnym produkt zostanie
naprawiony (lub wymieniony, według decyzji dystrybutora) bez opłaty w autoryzowanym serwisie.

• Gwarancja ta nie wpływa na, wynikające z umowy sprzedaży, ustawowe prawa konsumenta względem
sprzedawcy.

Produkt ten jest zgodny z wymogami dyrektywy 93/42/EEC oraz 1999/5/EC. Homologacja dostępna jest
pod następującym adresem www.support.polar.fi/declaration_of_conformity.html.

Produkt jest urządzeniem elektronicznym objętym dyrektywą 2002/96/EC Parlamentu i Rady Europejskiej
dotyczącą odpadów elektrycznych i elektronicznych (WEEE). W związku z powyższym produkt ten
powinien, po jego zużyciu, trafić do odpowiednich pojemników na śmieci (normy UE). Firma Polar
zachęca użytkowników do, zgodnej z prawem lokalnym, segregacji odpadów elektronicznych także poza
granicami UE. W ten sposób wnosisz wkład w minimalizację wpływu śmieci na środowisko naturalne i
ludzkie życie.

Prawa autorskie © 2008 Polar Electro Oy, FIN-90440 KEMPELE, Finland.

Polar Electro Oy posiada certyfikaty ISO 9001:2000.

Wszystkie prawa zastrzeżone. Zarówno instrukcja ta, jak i poszczególne jej fragmenty nie mogą być w
żadnej formie rozprzestrzeniane i kopiowane bez pisemnej zgody Polar Electro Oy. Nazwy i logo
oznaczone symbolem ™ w tej instrukcji obsługi i/lub na opakowaniu tego produktu są znakami
towarowymi Polar Electro Oy. Nazwy i loga oznaczone symbolem ® w tej instrukcji obsługi i/lub na
opakowaniu tego produktu są zastrzeżonymi znakami towarowymi Polar Electro Oy, za wyjątkiem
Windows, który jest zastrzeżonym znakiem towarowym Microsoft Corporation.

Zrzeczenie się odpowiedzialności
• Zawartość tej instrukcji służy jedynie do celów informacyjnych. Z uwagi na, prowadzone przez

producenta, ciągłe doskonalenie i rozwój produktów, opisany Polar może, bez wcześniejszego
powiadomienia, ulegać modyfikacjom.

• Polar Electro Inc./Polar Electro Oy nie ponosi odpowiedzialności za treść instrukcji ani nie udziela
gwarancji na inne, opisane w instrukcji, produkty.

• Polar Electro Inc./Polar Electro Oy nie ponosi odpowiedzialności za zniszczenia/ straty/ koszty i
wydatki-bezpośrednie, pośrednie lub przypadkowe, związane z użytkowaniem niniejszej instrukcji oraz
produktu.

Produkt ten jest chroniony jednym lub kilkoma z poniższych patentów.

FI68734, US4625733, DE3439238, GB2149514, HK81289, FI110303, WO96/20640, EP 0748185,
US6104947, FI112028, EP 0984719, US 6361502, FI 111801, US 6418394, EP1124483, WO9855023,
US6199021, US6356848, FI114202, US 6537227, FI110915, FI 113614.

Kolejne patenty w trakcie rejestracji.

Wyprodukowano przez:

Polar Electro Oy

Professorintie 5

FIN-90440 KEMPELE

Tel +358 8 5202 100
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Tel +358 8 5202 300

www.polar.fi [http://www.polar.fi]

POLSKI

Informacje serwisowe dla klienta 67

http://www.polar.fi


INDEKS

"Uczenie" . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
(Kadencja) Cadence: On /Off . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
(Prędkość)Speed on/ off . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Ćwiczenie interwałowe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

A.Lap on/off . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Analiza treningu za pomocą oprogramowania . . . . . . . . . . . . . . . 24

Blokada przycisków . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Dźwięk . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Fazy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Fitness test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Fitness Test Trend . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Gwarancja . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60, 65
Głośność . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

HRmax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38, 57
HRmax-p . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
HRsit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38, 58

Instrukcja postępowania . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Kalibracja wysokości . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Kasowanie pliku . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Limity prędkości . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Limity tętna . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Limity ustawiane ręcznie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Nadajnik . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Nagłówki . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Najczęściej Zgłaszane Pytania . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Odliczanie dni do wydarzenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
OwnIndex . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
OwnOptimizer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
OwnZone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22, 57

Pauza ćwiczenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Podświetlenie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Podświetlenie ekranu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Polar ProTrainer 5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24, 43
Power (moc) on/ off . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Powiększenie Wyświetlacza . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Przeglądanie informacji treningowych . . . . . . . . . . . . . . . . . . . . . . . . 24
Przesyłanie danych . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Przyciski odbiornika . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Przypomnienia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Resetowanie licznika . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Rozpoczęcie pomiaru tętna . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Rozpoczęcie zapisu ćwiczenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Sposób wyświetlania 12h/24h . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Stopień aktywności . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Strefa czasowa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Symbol roweru . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15, 18
Szacowane tętno maksymalne . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Słaba bateria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Totals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Tryb nocny . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Tworzenie ćwiczeń . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Ustawianie stopera . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Ustawienia ćwiczenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11, 12
Ustawienia daty . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Ustawienie alarmu/budzika . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Ustawienie godziny . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Ustawienie zapisu tempa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Uwagi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

VO2max . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38, 46

Wodoszczelność . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Wybierz język . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Wybór jednostek . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Wybór typu ćwiczenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Wydatek kaloryczny . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Zakładanie baterii . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Zapis okrążeń . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Zapis R R . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34, 35
Zaprogramowane ćwiczenie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43, 44
Zerowanie pliku totals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Zmiana wyświetlanych danych . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

POLSKI

68 Indeks


	CS600X Instrukcja obslugi
	Spis treści
	1. Wprowadzenie
	

	2. Czesci skladowe komputera rowerowego
	
	Akcesoria (Opcjonalnie)


	3. Rozpoczecie
	
	Pomiar rozmiaru kola.
	Podstawowe ustawienia
	Struktura Menu
	Zakladanie uchwytu na rower
	Mocowanie licznika na podstawce


	4. Przygotowanie do cwiczen
	Planowanie treningu
	Rodzaje cwiczen
	Tworzenie nowego cwiczenia za pomoca odbiornika
	Tworzenie nowego cwiczenia za pomoca ProTrainera 5

	Zakladanie nadajnika

	5. Trening
	Rozpoczecie treningu
	Informacje na wyswietlaczu
	Widok wykresu

	Personalizacja wyswietlacza licznika
	Symbole na wyswietlaczu
	Funkcje przycisków
	Kolejne okrazenie
	Blokada strefy
	Powiekszenie Wyswietlacza
	Podswietlenie ekranu (Night mode on)
	Wyglad menu Ustawien (Settings)
	Pauza podczas cwiczenia

	Wyznaczenie OwnZone
	Zatrzymanie cwiczenia

	6. Zakonczenie treningu
	
	Analiza wyników cwiczenia
	Exercise Log
	Podsumowanie tygodnia
	Totals
	Kasowanie plików


	7. Ustawienia
	
	Ustawienia cwiczenia
	Ustawienia funkcji
	GPS*
	Wysokosc
	Zapis tempa (usrednianie)
	Funkcja RR Data
	Automatyczny zapis okrazen
	Wyswietlanie tetna
	Sport zones

	Ustawienia rowerowe.
	Rozmiar kola
	(Predkosc)Speed: On / Off
	Czas przyjazdu.
	Autostart: On / Off
	Power*(moc): On / Off
	(Kadencja) Cadence*: On / Off

	Ustawienia uzytkownika
	Heart Rate: HRmax, HRsit
	Maksymalna ilosc tlenu przyswajana przez organizm: VO2max

	Ustawienia podstawowe
	Dzwiek
	Glosnosc
	TZ Alarm (Alarm przekroczenia stref)
	Blokada przycisków
	Jednostki
	Jezyk
	(Uspienie) Sleep

	Ustawienia zegarka
	Przypomnienia
	Wydarzenie
	Alarm
	Czas
	Time zone (strefa czasowa)
	Data

	Szybkie wybieranie (Quick Menu)

	8. Program treningowy
	Przegladanie programu
	Wykonywanie Zaprogramowanych Cwiczen
	Rozpoczecie cwiczenia
	Cwiczenie z fazami
	Wyglad ekranu podczas cwiczenia
	Funkcje, dostepne podczas cwiczenia
	(Menu okrazen) Lap menu


	9. Testy
	Polar Fitness Test™
	Przed wykonaniem testu
	Przeprowadzenie testu
	Po wykonaniu testu

	Polar OwnOptimizer™
	Przed wykonaniem testu
	Przeprowadzenie testu
	Po wykonaniu testu
	OwnOptimizer Trend
	Usun wartosci OwnOptimizer.
	Resetowanie pliku Trend
	Analiza wyników za pomoca programu Polar ProTrainer 5.


	10. Uzywanie nowego nadajnika
	Uzywanie nowego nadajnika
	"Uczenie" nowego sensora.


	11. Uzywanie nowych akcesoriów
	Uzywanie nowych akcesoriów.
	"Uczenie" nowego sensora predkosci.
	"Uczenie" nowego sensora kadencji*
	"Uczenie" nowego sensora pomiaru mocy*
	"Uczenie" nowego sensora GPS G3*


	12. Informacje podstawowe
	Polar Sport Zones
	Trening OwnZone
	Tetno maksymalne
	Tetno spoczynkowe
	Rezerwa tetna
	Zmiennosc tetna
	Zapis R-R
	

	13. Informacje serwisowe dla klienta
	Konserwacja i przechowywanie
	Konserwacja
	Serwis
	Wymiana baterii
	Wymiana Baterii Licznika

	Uwagi
	Zaklócenia podczas cwiczen
	Minimalizacja ryzyka podczas cwiczenia

	Specyfikacja techniczna
	Najczesciej Zglaszane Pytania
	Ograniczona gwarancja firmy Polar
	Zrzeczenie sie odpowiedzialnosci

	Indeks

